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1. Descripción  

 
La Guía Pedagógica es un documento que integra elementos técnico-metodológicos planteados de acuerdo con los principios y lineamientos del Modelo 
Académico del Conalep para orienta la práctica educativa del docente en el desarrollo de competencias previstas en los programas de estudio. 

La finalidad que tiene esta guía es facilita el aprendizaje de los alumnos, encauza sus acciones y reflexiones y proporciona situaciones en las que 
desarrollará las competencias. El docente debe asumir conscientemente un rol que facilite el proceso de aprendizaje, proponiendo y cuidando un 
encuadre que favorezca un ambiente seguro en el que los alumnos puedan aprender, toma riesgos, equivocase extrayendo de sus errores lecciones 
significativas, apoyase mutuamente, establecer relaciones positivas y de confianza, crea relaciones significativas con adultos a quienes respetan no por 
su estatus como tal, sino como personas cuyo ejemplo, cercanía y apoyo emocional es valioso. 

Es necesario destaca que el desarrollo de la competencia se concreta en el aula, ya que forma con un enfoque en competencias significa crea 
experiencias de aprendizaje para que los alumnos adquieran la capacidad de moviliza, de forma integral, recursos que se consideran indispensables 
para saber resolver problemas en diversas situaciones o contextos, e involucran las dimensiones cognitiva, afectiva y psicomotora; por ello, los 
programas de estudio, describen las competencias a desarrolla, entendiéndolas como la combinación integrada de conocimientos, habilidades, actitudes 
y valores que permiten el logro de un desempeño eficiente, autónomo, flexible y responsable del individuo en situaciones específicas y en un contexto 
dado. En consecuencia, la competencia implica la comprensión y transferencia de los conocimientos a situaciones de la vida real; ello exige relaciona, 
integra, interpreta, inventa, aplica y transferir los saberes a la resolución de problemas. Esto significa que el contenido, los medios de enseñanza, las 
estrategias de aprendizaje, las formas de organización de la clase y la evaluación se estructuran en función de la competencia a forma; es decir, el 
énfasis en la proyección currícula está en lo que los alumnos tienen que aprender, en las formas en cómo lo hacen y en su aplicación a situaciones de la 
vida cotidiana y profesional. 

Considerando que el alumno está en el centro del proceso formativo, se busca acercarle elementos de apoyo que le muestren qué competencias va a 
desarrolla, cómo hacerlo y la forma en que se le evaluará. Es decir, mediante la guía pedagógica el alumno podrá autogestiona su aprendizaje a través 
del uso de estrategias flexibles y apropiadas que se transfieran y adopten a nuevas situaciones y contextos e ir dando seguimiento a sus avances a 
través de una autoevaluación constante, como base para mejora en el logro y desarrollo de las competencias indispensables para un crecimiento 
académico y personal. 
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2. Datos de Identificación de la Norma  

 

Título:   

Unidad (es) de Norma Técnica de Competencia Laboral: 

 

Código:  Nivel de competencia:  
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3.  Generalidades pedagógicas  

Con el propósito de difundir los criterios a considera en la instrumentación de la presente guía entre los docentes y personal académico de planteles y 
Colegios Estatales, se describen algunas consideraciones respecto al desarrollo e intención de las competencias expresadas en los módulos 
correspondientes a la formación básica, propedéutica y profesional.  
Los principios asociados a la concepción constructivista del aprendizaje mantienen una estrecha relación con los de la educación basada en 
competencias, la cual se ha concebido en el Colegio como el enfoque idóneo para orienta la formación ocupacional de los futuros profesionales técnicos 
y profesionales técnicos bachiller. Este enfoque constituye una de las opciones más viables para logra la vinculación entre la educación y el sector 
productivo de bienes y servicios. 
En los programas de estudio se proponen una serie de contenidos que se considera conveniente aborda para obtener los Resultados de Aprendizaje 
establecidos; sin embargo, se busca que este planteamiento le dé al docente la posibilidad de desarrollarlos con mayor libertad y creatividad. 

En este sentido, se debe considera que el papel que juegan el alumno y el docente en el marco del Modelo Académico del Conalep tenga, entre otras, 
las siguientes características: 

EEll  aalluummnnoo::    EEll  ddoocceennttee::  

 Mejora su capacidad para resolver 
problemas. 

 Aprende a trabaja en grupo y comunica 
sus ideas. 

 Aprende a busca información y a 
procesarla.  

 Construye su conocimiento. 

 Adopta una posición crítica y autónoma. 

 Realiza los procesos de autoevaluación y 
coevaluación. 

 
 Organiza su formación continua a lo lago de su trayectoria profesional. 

 Domina y estructura los saberes para facilita experiencias de aprendizaje significativo. 

 Planifica los procesos de enseñanza y de aprendizaje atendiendo al enfoque por 
competencias, y los ubica en contextos disciplinares, curriculares y sociales amplios. 

 Lleva a la práctica procesos de enseñanza y de aprendizaje de manera efectiva, creativa e 
innovadora a su contexto institucional. 

 Evalúa los procesos de enseñanza y de aprendizaje con un enfoque formativo. 

 Construye ambientes para el aprendizaje autónomo y colaborativo. 

 Contribuye a la generación de un ambiente que facilite el desarrollo sano e integral de los 
estudiantes. 

 Participara en los proyectos de mejora continua de su escuela y apoya la gestión 
institucional. 
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En esta etapa se requiere una mejor y mayor organización académica que apoye en forma relativa la actividad del alumno, que en este caso es mucho 
mayor que la del docente; lo que no quiere decir que su labor sea menos importante. El docente en lugar de transmitir vertical y 
unidireccionalmente los conocimientos, es un mediador del aprendizaje, ya que:  

 Planea y diseña experiencias y actividades necesarias para la adquisición de las competencias previstas. Asimismo, define los ambientes de 
aprendizaje, espacios y recursos adecuados para su logro. 

 Proporciona oportunidades de aprendizaje a los estudiantes apoyándose en metodologías y estrategias didácticas pertinentes a los Resultados 
de Aprendizaje.  

 Ayuda también al alumno a asumir un rol más comprometido con su propio proceso, invitándole a toma decisiones.  

 Facilita el aprender a pensar, fomentando un nivel más profundo de conocimiento.  

 Ayuda en la creación y desarrollo de grupos colaborativos entre los alumnos.  

 Guía permanentemente a los alumnos.  

 Motiva al alumno a poner en práctica sus ideas, animándole en sus exploraciones y proyectos. 

Considerando la importancia de que el docente planee y despliegue con libertad su experiencia y creatividad para el desarrollo de las competencias 
consideradas en los programas de estudio y especificadas en los Resultados de Aprendizaje, en las competencias de las Unidades de Aprendizaje, así 
como en la competencia del módulo; podrá proponer y utiliza todas las estrategias didácticas que considere necesarias para el logro de estos 
fines educativos, con la recomendación de que fomente, preferentemente, las estrategias y técnicas didácticas que se describen en este apartado.  

Al respecto, entenderemos como estrategias didácticas los planes y actividades orientados a un desempeño exitoso de los resultados de aprendizaje, 
que incluyen estrategias de enseñanza, estrategias de aprendizaje, métodos y técnicas didácticas, así como, acciones paralelas o alternativas que el 
docente y los alumnos realizarán para obtener y verifica el logro de la competencia; bajo este tenor, la autoevaluación debe ser considerada también 
como una estrategia por excelencia para educa al alumno en la responsabilidad y para que aprenda a valora, critica y reflexiona sobre el 
proceso de enseñanza y su aprendizaje individual. 
Es así como la selección de estas estrategias debe orientase hacia un enfoque constructivista del conocimiento y esta dirigidas a que los alumnos 
observen y estudien su entorno, con el fin de genera nuevos conocimientos en contextos reales y el desarrollo de las capacidades reflexivas y críticas 
de los alumnos. 

Desde esta perspectiva, a continuación se describen brevemente los tipos de aprendizaje que guiarán el diseño de las estrategias y las técnicas que 
deberán emplearse para el desarrollo de las mismas:  
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TTIIPPOOSS  DDEE  AAPPRREENNDDIIZZAAJJEESS  

Aprendizaje Significativo  

Se fundamenta en una concepción constructivista del aprendizaje, la cual se nutre de diversas concepciones asociadas al cognoscitivismo, como la 
teoría psicogenética de Jean Piaget, el enfoque sociocultural de Vygotsky y la teoría del aprendizaje significativo de Ausubel. 

Dicha concepción sostiene que el ser humano tiene la disposición de aprender verdaderamente sólo aquello a lo que le encuentra sentido en virtud de 
que está vinculado con su entorno o con sus conocimientos previos. Con respecto al comportamiento del alumno, se espera que sean capaces de 
desarrolla aprendizajes significativos, en una amplia gama de situaciones y circunstancias, lo cual equivale a “aprender a aprender”, ya que de ello 
depende la construcción del conocimiento.  

Aprendizaje Colaborativo.  

El aprendizaje colaborativo puede definirse como el conjunto de métodos de instrucción o entrenamiento para uso en grupos, así como de estrategias 
para propicia el desarrollo de habilidades mixtas (aprendizaje y desarrollo personal y social).  En el aprendizaje colaborativo cada miembro del grupo es 
responsable de su propio aprendizaje, así como del de los restantes miembros del grupo (Johnson, 1993.) 

Más que una técnica, el aprendizaje colaborativo es considerado una filosofía de interacción y una forma personal de trabajo, que implica el manejo de 
aspectos tales como el respeto a las contribuciones y capacidades individuales de los miembros del grupo (Maldonado Pérez, 2007). Lo que lo 
distingue de otro tipo de situaciones grupales, es el desarrollo de la interdependencia positiva entre los alumnos, es decir, de una toma de conciencia de 
que sólo es posible logra las metas individuales de aprendizaje si los demás compañeros del grupo también logran las suyas. 

El aprendizaje colaborativo surge a través de transacciones entre los alumnos, o entre el docente y los alumnos, en un proceso en el cual cambia la 
responsabilidad del aprendizaje, del docente como experto, al alumno, y asume que el docente es también un sujeto que aprende.  Lo más importante 
en la formación de grupos de trabajo colaborativo es vigila que los elementos básicos estén claramente estructurados en cada sesión de trabajo. Sólo 
de esta manera se puede logra que se produzca, tanto el esfuerzo colaborativo en el grupo, como una estrecha relación entre la colaboración y los 
resultados (Jonson & F. Jonson, 1997).  

Los elementos básicos que deben esta presentes en los grupos de trabajo colaborativo para que éste sea efectivo son:  

 la interdependencia positiva.  

 la responsabilidad individual.  

 la interacción promotora.  

 el uso apropiado de destrezas sociales.  

 el procesamiento del grupo.  

Asimismo, el trabajo colaborativo se caracteriza principalmente por lo siguiente: 
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 Se desarrolla mediante acciones de cooperación, responsabilidad, respeto y comunicación, en forma sistemática, entre los integrantes 
del grupo y subgrupos.  

 Va más allá que sólo el simple trabajo en equipo por pate de los alumnos. Básicamente se puede orienta a que los alumnos intercambien 
información y trabajen en tareas hasta que todos sus miembros las han entendido y terminado, aprendiendo a través de la colaboración. 

 Se distingue por el desarrollo de una interdependencia positiva entre los alumnos, en donde se tome conciencia de que sólo es posible 
logra las metas individuales de aprendizaje si los demás compañeros del grupo también logran las suyas. 

 Aunque en esencia esta estrategia promueve la actividad en pequeños grupos de trabajo, se debe cuida en el planteamiento de las 
actividades que cada integrante obtenga una evidencia personal para poder integrarla a su portafolio de evidencias.  

 
Aprendizaje Basado en Problemas.  

Consiste en la presentación de situaciones reales o simuladas que requieren la aplicación del conocimiento, en las cuales el alumno debe analiza la 
situación y elegir o construir una o varias alternativas para su solución (Díaz Barriga Arceo, 2003). Es importante aplica esta estrategia ya que las 
competencias se adquieren en el proceso de solución de problemas y en este sentido, el alumno aprende a solucionarlos cuando se enfrenta a 
problemas de su vida cotidiana, a problemas vinculados con sus vivencias dentro del Colegio o con la profesión. Asimismo, el alumno se apropia de los 
conocimientos, habilidades y normas de comportamiento que le permiten la aplicación creativa a nuevas situaciones sociales, profesionales o de 
aprendizaje, por lo que: 

 Se puede trabaja en forma individual o de grupos pequeños de alumnos que se reúnen a analiza y a resolver un problema seleccionado o 
diseñado especialmente para el logro de ciertos resultados de aprendizaje.  

 Se debe presentar primero el problema, se identifican las necesidades de aprendizaje, se busca la información necesaria y finalmente se 
regresa al problema con una solución o se identifican problemas nuevos y se repite el ciclo. 

 Los problemas deben esta diseñados para motiva la búsqueda independiente de la información a través de todos los medios disponibles 
para el alumno y además genera discusión o controversia en el grupo. 

 El mismo diseño del problema debe estimula que los alumnos utilicen los aprendizajes previamente adquiridos. 

 El diseño del problema debe comprometer el interés de los alumnos para examina de manera profunda los conceptos y objetivos que se 
quieren aprender.  

 El problema debe estar en relación con los objetivos del programa de estudio y con problemas o situaciones de la vida diaria para que los 
alumnos encuentren mayor sentido en el trabajo que realizan. 

 Los problemas deben llevar a los alumnos a toma decisiones o hacer juicios basados en hechos, información lógica y fundamentada, y 
obligarlos a justificar sus decisiones y razonamientos. 

 Se debe centrar en el alumno y no en el docente. 
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TTÉÉCCNNIICCAASS  
Método de proyectos. 
Es una técnica didáctica que incluye actividades que pueden requerir que los alumnos investiguen, construyan y analicen información que coincida 
con los objetivos específicos de una tarea determinada en la que se organizan actividades desde una perspectiva experiencial, donde el alumno 
aprende a través de la práctica personal, activa y directa con el propósito de aclarar, reforzar y construir aprendizajes (Intel Educación). 

Para definir proyectos efectivos se debe considera principalmente que: 

 Los alumnos son el centro del proceso de aprendizaje.  

 Los proyectos se enfocan en resultados de aprendizaje acordes con los programas de estudio. 

 Las preguntas orientadoras conducen la ejecución de los proyectos.  

 Los proyectos involucran múltiples tipos de evaluaciones continuas. 

 El proyecto tiene conexiones con el mundo real. 

 Los alumnos demuestran conocimiento a través de un producto o desempeño. 

 La tecnología apoya y mejora el aprendizaje de los alumnos.  

 Las destrezas de pensamiento son integrales al proyecto.  

Para el presente módulo se hacen las siguientes recomendaciones: 

 Integra varios módulos mediante el método de proyectos, lo cual es ideal para desarrolla un trabajo colaborativo. 

 En el planteamiento del proyecto, cuida los siguientes aspectos: 

 Establecer el alcance y la complejidad. 
 Determinar las metas. 
 Definir la duración. 
 Determinar los recursos y apoyos. 
 Establecer preguntas guía. Las preguntas guía conducen a los alumnos hacia el logro de los objetivos del proyecto. La 

cantidad de preguntas guía es proporcional a la complejidad del proyecto. 
 Calendarizar y organizar las actividades y productos preliminares y definitivos necesarias para da cumplimiento al proyecto. 

 Las actividades deben ayudar a responsabilizar a los alumnos de su propio aprendizaje y a aplica competencias adquiridas en el salón de 
clase en proyectos reales, cuyo planteamiento se basa en un problema real e involucra distintas áreas. 
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 El proyecto debe implicar que los alumnos participen en un proceso de investigación, en el que utilicen diferentes estrategias de 
estudio; puedan participara en el proceso de planificación del propio aprendizaje y les ayude a ser flexibles, reconocer al "otro" y 
comprender su propio entorno personal y cultural. Así entonces se debe favorecer el desarrollo de estrategias de indagación, 
interpretación y presentación del proceso seguido. 

 De acuerdo a algunos teóricos, mediante el método de proyectos los alumnos buscan soluciones a problemas no convencionales, cuando 
llevan a la práctica el hacer y depura preguntas, debatir ideas, hacer predicciones, diseña planes y/o experimentos, recolecta y analiza 
datos, establecer conclusiones, comunica sus ideas y descubrimientos a otros, hacer nuevas preguntas, crea artefactos o propuestas muy 
concretas de orden social, científico, ambiental, etc. 

 En la gran mayoría de los casos los proyectos se llevan a cabo fuera del salón de clase y, dependiendo de la orientación del proyecto, en 
muchos de los casos pueden interactuar con sus comunidades o permitirle un contacto directo con las fuentes de información 
necesarias para el planteamiento de su trabajo. Estas experiencias en las que se ven involucrados hacen que aprendan a maneja y usa los 
recursos de los que disponen como el tiempo y los materiales. 

 Como medio de evaluación se recomienda que todos los proyectos tengan una o más presentaciones del avance para evalúa 
resultados relacionados con el proyecto.   

 Para conocer acerca del progreso de un proyecto se puede: 

 Pedir reportes del progreso. 
 Presentaciones de avance, 
 Monitorea el trabajo individual o en grupos. 
 Solicita una bitácora en relación con cada proyecto. 
 Calendariza sesiones semanales de reflexión sobre avances en función de la revisión del plan de proyecto. 

Estudio de casos. 

El estudio de casos es una técnica de enseñanza en la que los alumnos aprenden sobre la base de experiencias y situaciones de la vida real, y se 
permiten así, construir su propio aprendizaje en un contexto que los aproxima a su entorno. Esta técnica se basa en la participación activa y en procesos 
colaborativos y democráticos de discusión de la situación reflejada en el caso, por lo que: 

 Se deben representar situaciones problemáticas diversas de la vida para que se estudien y analicen.  

 Se pretende que los alumnos generen soluciones validas para los posibles problemas de carácter complejo que se presenten en la realidad 
futura.  

 Se deben proponer datos concretos para reflexiona, analiza y discutir en grupo y encontrar posibles alternativas para la solución del 
problema planteado. Guía al alumno en la generación de alternativas de solución, le permite desarrolla la habilidad creativa, la capacidad de 
innovación y representa un recurso para conecta la teoría a la práctica real. 
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 Debe permitir reflexiona y contrasta las propias conclusiones con las de otros, aceptarlas y expresa sugerencias. 

El estudio de casos es pertinente usarlo cuando se pretende: 

 Analizar un problema. 

 Determinar un método de análisis. 

 Adquirir agilidad en determina alternativas o cursos de acción. 

 Tomar decisiones. 

Algunos teóricos plantean las siguientes fases para el estudio de un caso: 
 Fase preliminar: Presentación del caso a los participantes 

 Fase de eclosión: "Explosión" de opiniones, impresiones, juicios, posibles alternativas, etc., por pate de los participantes.  

 Fase de análisis: En esta fase es preciso llega hasta la determinación de aquellos hechos que son significativos. Se concluye esta fase 
cuando se ha conseguido una síntesis aceptada por todos los miembros del grupo. 

 Fase de conceptualización: Es la formulación de conceptos o de principios concretos de acción, aplicables en el caso actual y que 
permiten ser utilizados o transferidos en una situación parecida.  

Interrogación. 
Consiste en lleva a los alumnos a la discusión y al análisis de situaciones o información, con base en preguntas planteadas y formuladas por el 
docente o por los mismos alumnos, con el fin de explora las capacidades del pensamiento al activa sus procesos cognitivos; se recomienda integra esta 
técnica de manera sistemática y continua a las anteriormente descritas y al aborda cualquier tema del programa de estudio. 

Participativo-vivenciales. 
Son un conjunto de elementos didácticos, sobre todo los que exigen un grado considerable de involucramiento y participación de todos los 
miembros del grupo y que sólo tienen como límite el grado de imaginación y creatividad del facilitador. 

Los ejercicios vivenciales son una alternativa para lleva a cabo el proceso enseñanza-aprendizaje, no sólo porque facilitan la transmisión de 
conocimientos, sino porque además permiten identifica y fomenta aspectos de liderazgo, motivación, interacción y comunicación del grupo, etc., 
los cuales son de vital importancia para la organización, desarrollo y control de un grupo de aprendizaje. 

Los ejercicios vivenciales resultan ser una situación planeada y estructurada de tal manera que representan una experiencia muy atractiva, divertida y 
hasta emocionante. El juego significa apartase, salirse de lo rutinario y monótono, para asumir un papel o personaje a través del cual el individuo pueda 
manifestar lo que verdaderamente es o quisiera ser sin temor a la crítica, al rechazo o al ridículo. 
El desarrollo de estas experiencias se encuentra determinado por los conocimientos, habilidades y actitudes que el grupo requiera revisa o analiza y por 
sus propias vivencias y necesidades personales. 
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4. Enfoque del módulo  

La competencia que se adquiere con el desarrollo del módulo, implica que el alumno maneje los fundamentos sistemas de control en general, de 
acuerdo a las especificaciones técnicas y de operación actuales, para la instalación y operación integral de los sistemas de control por computadora, 
con base a la documentación técnica, recomendaciones técnicas de los especialistas en la materia y boletines técnicos, así como identificar los sitios 
especializados en internet en el manejo de información técnica sobre este tema. 

Las competencias que se pretenden fomentar consideran actividades tales como manejar: los fundamentos de los sistemas de control en general y 
por computadora en particular, las arquitecturas de los sistemas de control más representativos, manejar los tipos de control que se pueden presentar 
en un sistema, los componentes de un sistema de control por computadora; operar los dispositivos de control del sistema por computadora, los 
componentes de interfase de la computadora con las facilidades de los sistemas de control por computadora e instalar los diferentes componentes 
físicos y lógicos de un sistema de control por computadora, respetando las recomendaciones de diseño técnico de los fabricantes y especialistas, de 
acuerdo a las recomendaciones de los manuales e información técnica especializada. 

Un sistema de control moderno es un sistema informático que recibe información de sistemas de medidas, la procesa y genera señales de mando a 
actuadores, de manera que el proceso se desarrolle según las directrices de optimización elegidas. Asimismo, almacena información recibida desde 
la planta y la presenta en un formato fácilmente comprensible. El empleo de un sistema informático, en vez de controladores de electrónica analógica, 
posee la ventaja de poder implementar algoritmos de control más complejos y eficaces, ello implica que el técnico en instalación de sistemas de 
control por computadora desarrolle un proceso formativo secuencial, aprovechando los conocimientos previos, que le permita realizar actividades 
profesionales especializadas en pequeñas y medianas empresas, como microempresario o contratista de otras con mayor presencia en el mercado, 
dedicadas a la instalación de sistemas de control por computadora. En base a esto, se requiere el desarrollo de competencias en la lectura e 
interpretación de manuales del equipo de y de los programas del equipo, tanto de sistema, como aplicativos y de diagnóstico, el manejo de los 
fundamentos de los sistemas de control, la identificación, operación y manejo de componentes que conforman un sistemas de control por 
computadora y con ello satisfacer las expectativas del mercado local y regional. 

Dado la naturaleza de formación integral, el módulo también fomenta en el alumno el desarrollo de las competencias disciplinares básicas y 
genéricas tales como la interpretación y emisión de mensajes pertinentes en distintos contextos mediante el uso de medios, códigos y herramientas 
apropiados para el desarrollo de algunos temas, estableciendo una postura personal sobre los temas abordados e identificando su relevancia general 
en su formación, considerando otros puntos de vista de manera crítica y reflexiva, y manteniendo relaciones interpersonales positivas con sus 
maestros y compañeros de grupo; mostrando una actitud respetuosa hacia la interculturalidad y la diversidad de creencias, valores, ideas y prácticas 
sociales; desarrollando habilidades matemáticas; desarrollando  innovaciones y proponiendo soluciones a problemas a partir  de métodos 
establecidos en este campo específico de los sistemas de control en general y por computadora en particular. 
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Instalación de sistemas de control por computadora

 

5. Orientaciones didácticas 
y estrategias de 
aprendizaje por unidad 

 

 

Unidad I: Identificación de los componentes de sistemas de control por computadora 

Orientaciones Didácticas (Dirigidas al docente) 

En esta unidad el alumno desarrolla las competencias relativas a manejar los componentes físicos y lógicos que integran un sistema de control por 
computadora, considerando las recomendaciones técnicas de fabricantes y especialistas. Asimismo, se desarrollan las competencias genéricas 
aplicables de manera natural a las competencias profesionales expresadas en los Resultados de Aprendizaje (RA), con el fin de promover una 
formación integral en el alumno, por lo que, durante todo el módulo, se fomenta: 

 La autonomía, responsabilidad y cuidado de sí mismo, mediante el autoconocimiento que cada alumno va desarrollando, tanto de sus cualidades, 
como de las áreas en que debe trabajar para su reforzamiento, determinando las acciones de corto, mediano y largo plazo, necesarias para la 
consecución de los objetivos definidos, considerando los factores sociales, económicos y personales que pueden influir positiva o negativamente en 
los objetivos contemplados para planear, elegir alternativas y administrar los recursos con los que cuenta.  

 Que el alumno proponga soluciones a problemas reales o hipotéticos, con base en actividades de búsqueda de información objetiva y veraz, 
aplicación de lo aprendido, e innovación en los métodos establecidos. Asimismo, se promueve el análisis crítico y fundamentado. 

 El interés y el respeto por la diversidad cultural en todas sus manifestaciones y que el alumno conozca puntos de vista diferentes sobre asuntos de 
interés público y personal, como condición para conformar el criterio personal de manera libre y sustentada. 

 El compromiso con el respeto a la persona, sin distinción de género, y la promoción de la igualdad de oportunidades para hombres y mujeres, 
asumiendo el alumno el papel de agente de cambio en el proceso de apertura de espacios de participación social y laboral de los que 
tradicionalmente se ha excluido al género femenino. 

 Que el alumno sea capaz de automotivarse en el logro de metas personales y académicas, de desarrollar la capacidad para regular y manejar sus 
propios impulsos y necesidades, asumir sus propios sentimientos y emociones y encauzarlos positivamente. 

 Que sea capaz de continuar aprendiendo de manera cada vez más eficaz y autónoma de acuerdo a los propios objetivos y necesidades, lo que 
implica aprender a autorregular su proceso de aprendizaje y a resolver diversas problemáticas de la vida académica y profesional, realizando de 
manera sistemática la planificación de las actividades de aprendizaje, la regulación de su proceso de aprendizaje y la evaluación de los resultados 
obtenidos tras la aplicación de la estrategia seleccionada. 
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Unidad I: Identificación de los componentes de sistemas de control por computadora 

Orientaciones Didácticas (Dirigidas al docente) 
 Que desarrolle capacidades para establecer una comunicación asertiva y efectiva, en diversos contextos, así como para identificar canales alternos 

y plurales que diversifiquen la obtención de la información y los enfoques con que ésta es tratada, utilizando una segunda lengua en situaciones 
cotidianas y en la consulta e interpretación de documentos técnicos. 

 Que aprenda a desempeñarse en situaciones de aprendizaje cooperativo y colaborativo, interactuando y trabajando para el logro de los objetivos y 
metas de aprendizaje del grupo, lo que contribuye también al desarrollo personal y social del alumno. 

 Que participe activamente en la democracia, traducida en una mayor equidad en diversos ámbitos sociales y profesionales de su entorno. Todo ello 
con capacidad de tolerancia y flexibilidad de criterio para alcanzar consensos. 

 Que incorpore medidas de seguridad e higiene en el desempeño de sus actividades profesionales. 

 Que adquiera el compromiso social de sustentabilidad, aplicable más allá de lo relativo al medio ambiente, orientándose a la satisfacción de las 
necesidades actuales, sin prejuicio de las futuras generaciones en el plano social, tecnológico, económico, cultural y cualquier otro que se relacione 
con la preservación y bienestar de la especie humana. 

 Que aprenda a minimizar el impacto de sus actividades cotidianas sobre el medio ambiente; consuma responsablemente; se desempeñe con 
seguridad, calidad y ética en espacios naturales y urbanos; elimine contaminantes o las fuentes de riesgo antes de que se generen, y seleccione y 
emplee materiales reciclables y biodegradables. 

 Que aprenda a movilizar sus recursos personales (conocimientos, habilidades, actitudes y valores) y utilizar estrategias efectivas de aprendizaje 
continuo para ingresar, mantenerse, desarrollarse y “navegar” en el mundo del trabajo, a lo largo de su trayectoria laboral, ya sea en contextos de 
trabajo dependientes como independientes. 

Para esto, en la presente unidad se aplicarán las técnicas: participo – vivenciales, de la interrogación y el estudio de casos, bajo el enfoque de 
aprendizaje significativo y colaborativo, descritos en el apartado 3 de la presente guía. 

 
Actividades sugeridas: 

1. Inicia la sesión presentándose ante el grupo. Da una introducción general del módulo y analiza en conjunto los resultados de aprendizaje que se 
pretenden lograr. Establece la forma de trabajo en clase y explica cómo se llevarán a cabo las actividades de evaluación, considerando las rúbricas 
correspondientes. Asimismo, invita a los alumnos a practicar los valores de respeto, dignidad, la no-violencia, la responsabilidad, el orden, la 
limpieza y el trabajo en equipo en todas sus actividades y relaciones que establezcan. 

2. Realiza una evaluación diagnóstica sobre conceptos de medición de variables eléctricas y electrónicas, operación de circuitos electrónicos 
analógicos, manejo de circuitos eléctricos, operación de circuitos electrónicos digitales, operación de equipo de cómputo, diagnóstico de equipo de 
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Unidad I: Identificación de los componentes de sistemas de control por computadora 

Orientaciones Didácticas (Dirigidas al docente) 
cómputo e interpretación de documentación técnica, para identificar los aspectos que son necesarios reforzar; Solicita a los alumnos su compromiso 
para estudiar lo necesario para alcanzar la competencia del módulo; cuyo producto final será un manual de instalación de un sistema de control por 
computadora.  Orienta al grupo en la definición de metas de aprendizaje y estrategias para alcanzarlas, haciendo uso de sus habilidades, valores y 
fortalezas. 

3. Asigna trabajo de campo a los alumnos, para visitar algunas PYMES y empresas de la localidad, con la finalidad de obtener un concepto general 
desde el punto de vista negocio y desde el punto de vista técnico, sobre las necesidades de los empleadores en materia de técnicos de instalación 
de sistemas de control por computadora calificados. 

4. Organiza al grupo en equipos de 4 personas solicitándoles una investigación vía internet acerca del control por computadora de algún evento, 
proceso, variable, etc., con la finalidad que los estudiantes conozcan sobre los fundamentos de un sistema de control en general en primera 
instancia y posteriormente sobre un sistema de control por computadora en particular; cierra el tema, con una presentación en power point sobre el 
concepto de control, objetivos de control, concepto de sistemas de control, sistema de control digital, componentes de un sistema de control por 
computadora, diagrama a bloques de un sistema de control por computadora ; solicita a los alumnos identifiquen una empresa que cuente con un 
sistema de control por computadora, negocien una visita y reporten: giro de la empresas, clientes de la empresa. el objetivo del sistema de control, 
los efectos que habría si no existiera el sistema de control, componentes hardware y software del sistema de control y arquitectura del sistema de 
control por computadora. 

5. Realiza demostración física, en video o algún otro medio, sobre los diferentes sistemas de control existentes, con la finalidad de inducir las variables 
que se consideran para clasificar a los sistemas en un entorno técnico y empresarial.  Asigna a los equipos de trabajos buscar ejemplos reales que 
representen a cada tipo de sistema de control. 

6. Presenta ejemplos y características de los servosistemas y sistemas de regulación. Asigna a alumnos complementar información y elaborar 
resumen sobre estos tópicos, correspondientes al tema de grupos de clasificación de sistemas de control. 

7. Plantea una problemática real relacionada con las formas de automatizar y controlar un sistema y pide la formulación de hipótesis, señalando una 
meta y soluciones concretas como: relevadores, microcontroladores y programas de simulación, así como la aplicación de conceptos tratados en 
clase para obtener la descripción sobre cada uno de estos aspectos 

8. Realiza la demostración de un sistema de control por computadora, con la finalidad de evidenciar los componentes y funciones de este. Asigna 
trabajo para elaborar resumen sobre los componentes de un sistema de control por computadora. 

9. Aplica un cuestionario escrito, con el propósito de afirmar el conocimiento del alumno sobre los fundamentos de los sistemas de control, la 
clasificación de los sistemas de control, servosistemas, sistemas de regulación, manejo de las formas de automatizar y controlar un sistema y 
solicita a los alumnos que respondan de manera individual las preguntas y posteriormente circulen por el aula buscando compañeros que hayan 
contestado las preguntas que ellos no pudieron para completar la información que les falte. 
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Unidad I: Identificación de los componentes de sistemas de control por computadora 

Orientaciones Didácticas (Dirigidas al docente) 
10. Presenta un sistema controlado por computadora, con la finalidad de que el alumno identifique las unidades convencionales, los sistemas 

modulares, los sistemas de control distribuidos. Solicita al alumno complemente la información a través de consultas en cualquier fuente de 
información y elabore una presentación para ser discutida en el aula y conciliarla apegándose a las normas y recomendaciones técnicas.  

11. Utiliza presentaciones de power point, rotafolios y componentes reales con la finalidad de que el alumno identifique las diferentes arquitecturas de 
un sistema de control: iniciando con la básica y agregando componentes para ir conformando la de un sistema de control automático de lazo abierto, 
la de lazo cerrado, por computadora o control digital, así como los componentes de un sistema de control distribuido. Asigna a los equipos de 
trabajo, recabar información con consultas en sitios especializados y proveedores, con la finalidad que cada equipo presente una arquitectura, con 
su descripción, marca, proveedores y características de sus componentes. 

12. Orienta y apoya la realización de la práctica no. 1: “Elabora una maqueta con la arquitectura de un sistema de control por computadora, 
simulando una instalación real”, correspondiente a la actividad de evaluación 1.2.1. 

13. Organiza una rueda de ideas sobre los tipos de control que existen en un sistema de control, identificando las variables que determinan el tipo de 
control y los objetivos de cada uno. 

14. Enriquece el tema con un mapa conceptual de sistemas automatizados de control por computadora, presentando físicamente los componentes 
hardware y software de este sistema, su descripción, funciones y objetivo dentro del sistema; presenta manuales de algunos componentes, los 
interpreta con la finalidad de familiarizar al estudiante con manuales de estos componentes. Asigna a los estudiantes la lectura de un manual 
diferente a cada equipo. 

15. Organiza subgrupos de discusión sobre los componentes hardware y software de un sistema de control por computadora, así como de la 
interpretación de los manuales de los mismos. Cierra el tema después de profundizar en la funciones de cada componentes en un sistema de 
control por computadora, presentando físicamente los componentes y en el caso de software, la proyección en la pantalla del software instalado, 
revisando los menús y facilidades. Asigna por equipo de trabajo la elaboración de una maqueta representando un sistema de control por 
computadora. 

16. Realiza la presentación de un diagrama a bloques, en el cual va relacionando cada bloque, con su correspondiente componente, ya sea hardware o 
software, en un computador de control real, describiendo los programas de aplicación y el puerto paralelo RS 232. Solicita una consulta en cualquier 
fuente disponible sobre las aplicaciones de control que se le pueden asociar al puerto paralelo con interfase RS232 y sobre los PLC´s, y una 
presentación en el aula con la información recabada. 

17. Expone mediante un video o una película las funciones de control que pueden realizar los puertos paralelos y los PLC´s, enfatizando la parte que 
aplica a este módulo para el desarrollo de competencias. Solicita la consulta sobre proveedores, marcas y aplicaciones en un sistema de control de 
PLC´s para su presentación en el aula; al final de las presentaciones cada alumno deberá toma notas de los aspectos relevantes de la clase. 

18. Organiza al grupo en equipos de trabajo, para asignar la consulta sobre las diferentes modalidades de software de control para computadora, 
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Orientaciones Didácticas (Dirigidas al docente) 
dispositivos de control y la conectividad entre aplicaciones del sistema de control por computadora. Asigna la elaboración de un tríptico o díptico con 
dicha información para compartirlos en el aula. 

19. Presenta el estándar IEEE 488 de controladores e interfases, profundizando en el rol que juega en un sistema de control y en un sistema de control 
por computadora. Solicita al alumno una investigación individual sobre la consulta de ejemplos de componentes que cumplen con este estándar, en 
qué tipo de instalaciones se utilizan y que marcas y proveedores existen en el mercado. 

20. Asigna la elaboración de un diagrama a bloques enriquecido con la información manejada hasta el momento, describiendo funciones de cada 
bloque, representando cada componente con una marca comercial y las características técnicas de cada componente, mencionando una instalación 
real en la cual se use uno o varios componentes presentados. 

21. Orienta y apoya la realización de la práctica no. 2 “Presentación de un caso real de un sistema de control por computadora”, 
correspondiente a la actividad de evaluación 1.4.1.  

22. Realiza el resumen de la unidad reforzando aquéllos aspectos que considere sean necesarios, considerando el resultado en el desarrollo de las 
competencias de los alumnos. 

 

 
Estrategias de aprendizaje (dirigidas al alumno) Recursos académicos 

El alumno: 

 Expone sus expectativas del curso y analiza las actividades de aprendizaje, los criterios de 
evaluación y el método de aprendizaje. Plantea sus dudas y toma nota sobre los puntos 
explicados por el docente. 

 Contesta la evaluación diagnóstica sobre conceptos de medición de variables eléctricas y 
electrónicas, operación de circuitos electrónicos analógicos, manejo de circuitos eléctricos, 
operación de circuitos electrónicos digitales, operación de equipo de cómputo, diagnóstico 
de equipo de cómputo e interpretación de documentación técnica. Se compromete a 
reforzar los aspectos importantes del tema y a adquirir los conocimientos mínimos 
necesarios para cursar él módulo, por lo que establece metas y estrategias para su logro. 

 Realiza visitas a PYMES y organizaciones que utilizan sistemas controlados por equipo de 

 Computadora con procesador de texto y software 
de presentación. 

 Papel para registro de información. 
 1 computadora para el docente. 
 1 cañón de proyección. 
 1 pantalla de proyección. 
 1 escritorio. 
 Mesas de trabajo. 
 1 Computadoras por cada tres participantes. 
 sistema operativo Windows vista o Windows 7. 
 1 manual por cada equipo de cómputo. 
 Conexión a internet de banda ancha, mínimo de 2 

Mb. 
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cómputo, con la finalidad de realizar una investigación y consulta con las necesidades y 
requerimientos de los empleadores en materia de técnicos en Instalación de sistemas de 
control por computadora; previo a la visita elabora un guión con el objetivo de realizar una 
entrevista planeada y lograr los objetivos planeados; elabora un reporte con los resultados 
de las entrevistas. 

  Identifica una empresa que cuente con un sistema de control por computadora, negocia la 
visita y reporta: giro de la empresa, clientes de la empresa. el objetivo del sistema de 
control, los efectos que habría si no existiera el sistema de control, componentes hardware 
y software del sistema de control, arquitectura del sistema de control por computadora. 

 Consulta en equipos de trabajo, ejemplos reales que representen a cada tipo de sistema de 
control y los expone en el aula. 

 Aplica los conceptos y procesos tratados en la clase respondiendo a la pregunta ¿Qué 
pasaría sino hubiera o no existiera…? y completa la pregunta con algún concepto o proceso 
sobre formas de automatizar y controlar un sistema. Así constatará que evitar omitir un 
paso o tener la carencia de un dato le exige probar validez y repercusiones en la práctica. 

 Resume la discusión y exposición del aula sobre los componentes que conforman un 
sistema de control por computadora 

 Responde de manera individual las preguntas acerca de los fundamentos de los sistemas 
de control, la clasificación de los sistemas de control, servosistemas, sistemas de 
regulación, manejo de las formas de automatizar y controlar un sistema; y posteriormente 
circula por el aula buscando compañeros que hayan contestado las preguntas que no pudo 
para completar la información que le falta. 

 Identifica la información sobre las unidades convencionales, los sistemas modulares, los 
sistemas de control distribuidos a través de consultas en a través de consultas en cualquier 
fuente de información disponible, elabora presentación para ser discutida en el aula y 
conciliarla a las normas y recomendaciones técnicas. 

 Presenta la arquitectura de un sistema de control por computadora, seleccionando un 
medio de presentación que transmita con claridad la información apegándose lo más 
cercano a la realidad, complementando la información con las discusiones realizadas en el 
aula, con la finalidad de construir la competencia de esta unidad de aprendizaje. 

 Programas aplicativos de control. 
- LabView. 
- MathLab. 
- RsView. 
- Delphi. 
- Lookout. 
- DDE intercambio dinámico de datos. 

 AW-SYS software didáctico de simulación  
 5 PLC´s de diferentes maracas y características. 
 1 motor de corriente continúa. 
 Convertidores AD y DA. 
 Multiplexores. 
 Sensores. 
 Actuadores 

 Ollero Baturone, Aníbal, Control por 
computadora descripción interna y diseño 
óptico, Editorial Marcombo, España, 2006. 

 Pérez Cruz., Pineda, Manuel, Automatización 
de maniobras industriales, mediante autómatas 
programables. Alfaomega, México, 2008. 

 Wittenmark, B.; Aström, K.; Arzen, K.E., 
Computer control: an overview; IFAC 
Professional Brief. Instituto Tecnológico de 
Lund; Suecia; 2002. 

 Componentes para computadoras, Disponible 
en : 
http://www.pctechguide.com/02Processors.htm 
(10/07/2015) 

 Componentes para computadoras, Disponible 
en:http://www.intel.com/products/index.htm?iid
=gg_work+home_products (10/07/2015) 

 Control por computadora de 
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 Realiza la práctica no. 1 “Elabora una maqueta con la arquitectura de un sistema de 
control por computadora, simulando una instalación real”, correspondiente a la 
actividad de evaluación 1.2.1. 

 Participa activamente en una rueda de ideas sobre los tipos de control que existen en un 
sistema de control, profundizando en los tipos de control en un sistema de control, sus 
objetivos y variables de operación.  

 Interpreta manuales proporcionados por el docente, con la finalidad de familiarizarse con la 
estructura del mismo, su contenido y fundamentalmente con la información técnica de los 
sistemas controlados por computadora, los componentes hardware y software que lo 
conforman, sus funciones y resultados esperados; elabora resumen de la información 
fundamental para su revisión por parte del docente. 

 Elabora maqueta sobre un sistema de control por computadora, representando los 
componentes hardware y software que lo conforman, sus funciones, variables de operación 
para realizar el control, la información de entrada a cada bloque, la información de salida de 
cada bloque y del sistema, apoyándose en la información manejada en el aula, en la 
documentación técnica, en consulta en sitios especializados de internet y en fuentes 
bibliográficas. 

 Profundiza en uno de los programas de aplicación para simulación y control asignados por 
el docente, dentro de los que se encuentran: LabView, MathLab, RsView. Delphi, Lookout, 
DDE intercambio dinámico de datos, realizando una presentación sobre el objetivo, 
funciones principales y estructura del programa para realizar el control y elabora una 
presentación en power point sobre el puerto paralelo RS 232 y PLC´s, las funciones y 
aplicaciones que se asocian con ellos, apoyadas por el desarrollo de algún programa, 
fundamentalmente orientadas a conformar un sistema de control o formar parte de un 
sistema de control, la cual presentará para discusión en el aula. 

 Consulta sobre proveedores y marcas de PLC´s y las diferencias más importantes entre 
ellos. 

 Elabora tríptico o díptico, en el que incluye la información manejada en el aula por el 
docente, sobre los diferentes software de control disponibles comercialmente, los 
dispositivos de control y la conectividad entre aplicaciones del sistema de control por 
computadora describiendo funciones de cada bloque, representando cada componente con 

servomecanismos, Disponible en: 
http://www.esi2.us.es/~fsalas/asignaturas/LCA
3T_05_06/practica4_06.pdf, (10/07/2015). 

 Control por computadora National por 
Computadora, Disponible en: 
http://digital.ni.com/worldwide/latam.nsf/web/all
/A64B197A80F62E3C86256A5D0082EE06, 
(10/07/2015) 

 Descarga  de controladores e información 
técnica, Disponible en: 
http://downloadcenter.intel.com/default.aspx?ii
d=gg_work+home_dowloads (10/07/2015) 

 Diferentes cursos y uso de software, 
Disponible en: 
http://www.lawebdelprogramador.com/cursos/ 
(10/07/2015). 

 Elementos finales de control. Disponible en: 
http://html.rincondelvago.com/elementos-
finales-de-control-industrial.html (10/07/2015) 

 Software didáctico para simulación de PLC´s, 
instalaciones e interfase a sistemas de control, 
Disponible en: 
http://www.autoware.com/spanish/demo.htm, 
(10/07/2015). 

 Teoría de sistemas de control, Disponible en, 
http://csd.newcastle.edu.au/, (10/07/2015). 

 Tutorial de computación, Disponible en: 
http://www.bbc.co.uk/computertutor/computertu
torone/popup_flash.shtml?h=770. 
(10/07/2015). 

 Tutoriales y artículos, Disponible en: 
http://www.pctechguide.com/02Processors.htm 
(10/07/2015). 
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Estrategias de aprendizaje (dirigidas al alumno) Recursos académicos 

una marca comercial y las características técnicas de cada componente, mencionando una 
instalación real en donde se usen uno o varios componentes presentados y los comparte 
con sus compañeros de clase. 

 Consulta de manera individual ejemplos de componentes que cumplen con el estándar 
IEEE 488 de controladores e interfases, en qué tipo de instalaciones se utilizan y que 
marcas y proveedores existen en el mercado 

 Realiza la práctica no. 2 “Presentación de un caso real de un sistema de control por 
computadora”, correspondiente a la actividad de evaluación 1.4.1.  

 Participa en la realización del resumen de la unidad preguntando al docente y aclarando 
sus dudas sobre aquéllos aspectos que considere necesarios. 
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Unidad II: Instalación de sistemas de control por computadora. 

Orientaciones Didácticas (Dirigidas al docente) 

Esta unidad está enfocada a que el alumno adquiera la competencia en instalar los componentes físicos y lógicos de un sistema de control por 
computadora considerando las especificaciones técnicas de diseño así como recomendaciones de fabricantes y especialistas, y refuerza las 
competencias genéricas descritas en la Unidad de Aprendizaje I, con el fin de promover una formación integral del alumno. 

Para esto, en la presente unidad se aplicarán las técnicas: de interrogación y método de proyectos, descritos en el apartado 3 de la presente guía; 
bajo el enfoque de aprendizaje colaborativo, y estudio de casos, bajo el enfoque de aprendizaje significativo y colaborativo, descritos en el apartado 3 
de la presente guía. 

 
Actividades sugeridas: 

1. Organiza al grupo en equipos de trabajo asignando trabajo en el aula, para la elaboración en un rotafolio o material similar, un diagrama a bloques 
de un sistema de control representando el objetivo de control y las variables representativas del sistema.  

2. Complementa la información, retroalimentando conceptos con el fin de construir la competencia de la unidad, sobre los objetivos de control de un 
sistema, las mediciones a realizar, las variables manipulables, situaciones de riesgo y procedimiento de arranque y parada. 

3. Promueve una lluvia de ideas acerca de las funciones que realiza un sistema de control por computadora registrándolas en el pizarrón; utiliza 
simulador de un sistema de control , mostrando las funciones vitales que realiza , con la finalidad de que los alumnos vayan seleccionando las 
escritas en el pizarrón, con las que muestre el simulador; debe mostrar mínimo: el muestreo de la señal de control, conversión a señal digital de la 
señal muestreada, procesamiento de las señales de error, generación de señales de control a aplicar, conversión de la secuencia de señales de 
control a digitales, reconstrucción de la señal, conversión de las señales digitales a analógicas, conversión de las señales analógicas a digitales, 
interconexión entre todos los dispositivos del sistema a controlar, comparación de las funciones de control con el software de control; solicita al 
alumno la elaboración de un esquema de círculos de la demostración realizada. 

4. Utiliza el simulador para describir el manejo de las señales de un sistema de control por computadora. Asigna al alumno complementar el esquema 
de círculos elaborado en la sección anterior, marcando en que punto se generan señales, cuales son sus características y el proceso de 
transformación que experimentar para que el sistema de control logre sus objetivos. 

5. Realiza una demostración práctica usando el simulador de un sistema de control LabView su instalación e implementación, su objetivo, ventajas, 
desventajas y elementos que simular, además de profundizar en los actuadores controlados por el puerto paralelo RS232. Asigna la elaboración de 
un manual que describa los puntos anteriores correspondientes al simulador LabView. 

6. Guía la actividad y plantea preguntas para explicar cuales serían las consecuencias de generar el problema del control sin automatización hasta 
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Unidad II: Instalación de sistemas de control por computadora. 

Orientaciones Didácticas (Dirigidas al docente) 
consolidar eficientemente las respuestas de los alumnos. Induce la utilización de los sistemas SCADA; profundiza en este tipo de sistemas, sus 
funciones, resultados y beneficios, así como los HMI.  

7. Realiza la demostración práctica sobre la operación de los sistemas SCADA. Solicita al alumno elabore un resumen sobre lo expuesto y 
demostrado. 

8. Solicita al alumno una serie de actividades a desarrollar en el aula con el simulador, relacionando éstas con las realizadas en los sistemas SCADA. 
Solicita complemente el manual cuya elaboración inició con anterioridad, con esta información y la del apartado anterior. 

9. Realiza en esquemas el resumen de la unidad resolviendo las dudas que hasta el momento pudieran surgir en los alumnos asegurándose de 
resolver todas las que surjan. 

10. Orienta y apoya la realización de la práctica no. 3 “Presenta la operación de un simulador y los resultados obtenidos”, correspondiente a 
la actividad de evaluación 2.1.1. 

11. Realiza una serie de preguntas detonadoras para crear la necesidad de pensar en la forma en que deben comunicarse los diferentes componentes 
de un sistema de control por computadora, promoviendo la lluvia de ideas con la finalidad de encontrar soluciones a este planteamiento; retoma 
ideas planteadas por los alumnos para introducir el concepto de interfase entre la computadora, los dispositivos de control y el sistema a controlar.  

12. Realiza una exposición en power point, sobre las técnicas de interfase entre los componentes, relacionándolas con la problemática generada en la 
sección anterior. Solicita al alumno elaborar un reporte sobre la interfase entre los componentes y las técnicas utilizadas para intercambiar 
información. 

13. Profundiza en la forma en que se comunican los dispositivos de interconexión, los dispositivos de adquisición de datos, los dispositivos de 
accionamiento, los dispositivos en el sistema de accionamiento, los dispositivos del manejo de perturbaciones, los dispositivos de interfase con el 
usuario, utilizando como apoyo un diagrama a bloques. Solicita a los alumnos que organizados en equipo de trabajo, que desarrollen cada bloque, 
con sus respectivos dispositivos y variables de operación que conjuntamente logran que opere el sistema de control, con la finalidad de exponerlo 
en el aula.  

14. Organiza la exposición de los bloques de la sección anterior sobre la forma en que se comunican y operan entre ellos; alternadamente un grupo 
expondrá y otro lo relacionará con la demostración en el simulador LabView o similar. Solicita a los alumnos tomen fotografías ó impresiones de 
cada pantalla generada y enriquezcan el manual que se viene elaborando con anterioridad. 

15. Expone mediante esquemas resumen de la unidad, realizando preguntas para verificar la comprensión de lo expuesto y la adquisición del 
conocimiento, escribiendo los nombres de los alumnos en tarjetas y preguntándoles a todos. Observa una actitud de igualdad y equidad de género 
dentro y fuera del aula 
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Unidad II: Instalación de sistemas de control por computadora. 

Orientaciones Didácticas (Dirigidas al docente) 
16. Orienta y apoya la realización de la práctica no.4 “Identifica las funciones de LabView”, correspondiente a la actividad de evaluación 2.2.1. 
17. Realiza la exposición sobre la forma de implementar la arquitectura de control por computadora con base a los resultados de la simulación, se apoya 

con una presentación dinámica en power point de manera que sea claro en la aparición paulatina de cada componente. Solicita a los alumnos 
elaboren la arquitectura en base visto en el aula. 

18. Explica los componentes del software del sistema de control por computadora. Solicita a los alumnos elaboren un diagrama a bloque representando 
cada módulo de software por un bloque, describiendo las funciones de cada uno y la forma en que contribuyen a que el sistema de control por 
computadora realice sus funciones de control. 

19. Realiza una demostración práctica con el software LabView la instalación de los componentes del sistema de control por computadora para que 
realice sus funciones de control, considerando la configuración tanto de hardware como de software. Solicita al alumno elabore manual de 
instalación y configuración de componentes en LabView. 

20. Orienta y apoya la realización de la práctica no.5 “Instala y opera el sistema de control LabView.”, correspondiente a la actividad de 
evaluación 2.3.1. En la rúbrica correspondiente se incluye una Coevaluación. 

21. Presenta el resumen de la unidad en esquemas a través de una presentación en power point, aclarando las dudas de los alumnos y retomando los 
temas que pudieran quedar confusos. 

 

 
Estrategias de aprendizaje (dirigidas al alumno) Recursos académicos 

 Elabora diagrama a bloques sobre un sistema de control, representando la variable(s) a 
controlar, las variables a manejar en cada bloque y las funciones de cada bloque que 
representarán a un componente o conjunto de componentes, con la finalidad de 
discutirlas en el aula y elaborar un documento final de estudio y consulta permanente. 

 Complementa y actualiza la documentación de estudio y consulta elaborada al 
momento, con la última exposición-discusión enfocada a: objetivos de control de un 
sistema, las mediciones a realizar, las variables manipulables, situaciones de riesgo y 
procedimiento de arranque y parada. 

 Elabora un esquema de círculos con base a la demostración de la operación de un 

 Computadora con procesador de texto y software 
de presentación. 

 Papel para registro de información. 
 8 Computadoras de escritorio. 
 1 manual por cada equipo de cómputo. 
 Conexión a internet 
 Cámara fotográfica. 
 Utilerías de diagnóstico y mantenimiento: 
 Manuales técnicos de los equipos 
 Kosierok, Charles. How to build your own PC, 
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Estrategias de aprendizaje (dirigidas al alumno) Recursos académicos 

sistema, mostrado en el aula por el docente en el cual identifica y documenta las 
funciones de un sistema de control por computadora, 

 Complementa y actualiza el esquema de círculos elaborado con anterioridad con las 
señales en el sistema de control por computadora y su manejo para el logro s de los 
objetivos de control del sistema. 

 Elabora manual de operación de LabView, considerando la demostración de la 
operación del mismo realizada en el aula por el docente, incluyendo como mínimo los 
siguientes puntos: objetivo, beneficios, desventajas y elementos que simular, instalación 
e implementación del simulador; además de profundizar en los actuadores controlados 
por el puerto paralelo RS232. 

 Elabora resumen de los sistemas SCADA considerando la información manejada en el 
aula y complementada con consultas en información especializada existente en internet 
de proveedores, escuelas y centros de investigación; establece la relación entre los 
sistemas SCADA, los mecanismos de comunicación hombre máquina (HMI human 
machine interface) y los sistemas de control por computadora. 

 Complementa el manual sobre la operación y funciones del simulador de control por 
computadora, relacionando las funciones de éste con los sistemas SCADA. 

 Atiende la exposición sobre el resumen de la Unidad hecha por el docente, exponiendo 
todas sus dudas al respecto. 

 Realiza la práctica no.3 “Presenta la operación de un simulador y los resultados 
obtenidos”, correspondiente a la actividad de evaluación 2.1.1.  

 Participa activamente en la lluvia de ideas propiciada por el docente, sobre la 
comunicación entre los diferentes componentes de un sistema de control por 
computadora, resumiendo los resultados de la discusión en el aula y asegurándose de 
que todos sus compañeros participen en la actividad. 

 Elabora un reporte sobre la interfase entre los componentes de un sistema de control 
por computadora, así como las técnicas de intercambio de información entre los 
componentes. 

 Elabora diagrama a bloques, desarrollando cada bloque el cual debe representar los 

http://www.pcguide.com/byop/index.htm 
(10/07/2015) 

 Martín, José M. Hardware microinformático, 
3ª Ed. Alfaomega RA MA; México, 2002. 

 Martín, José María. Actualización, 
configuración, mantenimiento y reparación, 4ª 
Ed. Alfaomega Grupo Editor; México, 2008. 

 Componentes para computadoras, Disponible 
en : 
http://www.pctechguide.com/02Processors.htm 
(10/07/2015) 

 Diferentes cursos y uso de software, 
Disponible en: 
http://www.lawebdelprogramador.com/cursos/. 
(10/07/2015) 

 Habilidades básicas de computación, 
Disponible en: http://www.bcot1.com/. 
(10/07/2015) 

 Herramientas para corregir errores, Disponible 
en: http://www.fixerrortoday.com/tidpp-
common_computer_error-
ppc020?gclid=COvV7PaWhp0CFc9h2godwk98
aw, (10/07/2015). 

 Estándar IEEE 488, controladores e interfases 
en un sistema de control, Disponible en: 
http://digital.ni.com/worldwide/latam.nsf/web/all
/A863DBF5C3DA3F8D86256B600065F1F8 
(10/07/2015) 

 Información técnica, Disponible en: 
http://www.theinquirer.es/2009/01/06/nvidia-
gt212-384-stream-processors-en-40-nm-y-
gddr5.html. (10/07/2015) 

 Mantenimiento de Windows, Disponible en: 
http://www.ayudadigital.com/windows/configurar
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Estrategias de aprendizaje (dirigidas al alumno) Recursos académicos 

siguientes aspectos: comunicación entre los dispositivos de interconexión, de 
adquisición de datos, de accionamiento, del manejo de perturbaciones, de interfase con 
el usuario, con sus respectivos dispositivos y variables de operación que conjuntamente 
logran que opere el sistema de control, con la finalidad de exponerlo en el aula.  

 Expone cada bloque desarrollado en la sección anterior y alternadamente usa el 
simulador para identificar y mostrar el bloque que en su momento presente otro grupo 
de trabajo; obtiene la impresión de las diferentes pantallas del simulador ó toma 
fotografías se las mismas, con la finalidad de enriquecer el manual cuya elaboración 
inició con anterioridad. 

 Participa respondiendo las preguntas del docente acerca del resumen de la Unidad y 
aclarando las dudas que al momento pudieran surgir. 

 Realiza de la práctica no. 4 “Identifica las funciones de LabView”, 
correspondiente a la actividad de evaluación 2.2.1.  

 Elabora por solicitud del docente, la arquitectura de un sistema de control por 
computadora con base en la simulación vista en el aula 

 Participa en la lluvia de ideas sobre la implementación de la arquitectura hardware y 
software de un sistema de control por computadora y elabora paralelamente la 
arquitectura con la información que se vaya discutiendo en el aula. 

 Elabora diagrama a bloques de la arquitectura, representando en cada boque el 
hardware y en el interior el software que reside en el componente hardware y en 
términos generales la función que realiza de manera conjunta. 

 Elabora manual de instalación y configuración de componentes y funciones de 
LabView, con base en la demostración de operación del simulador realizada en el aula, 
ampliada con el manual del simulador. 

 Realiza de la práctica no. 5 “Instala LabView y lo opera”, correspondiente a la 
actividad de evaluación 2.3.1 y participa en la actividad de Coevaluación. 

 Aclara sus dudas y pregunta al docente acerca de los temas que pudieron quedar 
confusos durante el desarrollo de la unidad. 

 

_arranque_windows.htm (10/07/2015) 
 Mantenimiento y configuración de Windows 

XP, disponible en: www.mundodescargas.com. 
(10/07/2015) 

 Tipos, modos, formas y velocidades de 
transmisión, Disponible en: 
http://www.textoscientificos.com/  (10/07/2015) 
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6. Prácticas/Ejercicios 
/Problemas/Actividades 

 

 
Unidad de aprendizaje: Manejo de los componentes de sistemas de control por computadora. Número: 1 
  

Práctica: Elabora una maqueta con la arquitectura de un sistema de control por 
computadora, simulando una instalación real.

Número: 1 

  

Propósito de la práctica: Manejar las arquitecturas de los sistemas de control más representativos 
  

Escenario: Taller o laboratorio Duración  3 horas 
 

Materiales, herramientas, instrumental, 
maquinaria y equipo Desempeños 

Material por equipo de trabajo de 4 integrantes: 
 Lápiz 
 1 Computadora de escritorio con procesador 

de texto y software de presentación. 

1. Integra equipos de trabajo de 4 participantes: 

2. Aplica las medidas de seguridad e higiene en el desarrollo de la práctica. 

3. Prepara el equipo, las herramientas y los materiales a utilizar 

Considera los cuidados al estar con equipo energizado y delicado al uso violento. 

Realiza la identificación de componentes hardware una instalación real de un sistema controlado por 
computadora, retomando las actividades de la práctica No. 1. 

Identificación de los componentes y su tecnología. 
4. Identifica la tecnología utilizada en el sistema de control por computadora. Determinando cuál 

está presente 

 Unidades convencionales. 
- Sensores. 
- Transmisores de señal. 
- Controladores.  
- Transductores. 

 Sistemas modulares (módulos aplicativos). 
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Materiales, herramientas, instrumental, 
maquinaria y equipo Desempeños 

- Microprocesadores. 
- Microcontroladores de función específica. 
- PLC´s. 

 Sistemas de control distribuido (equipos conectados en red). 
- Acondicionadores de señal. 
- Unidades de control. 
- Consolas de trabajo computarizadas. 
- Monitores de despliegue de información. 
- Impresoras. 

Reconoce las actividades que le resultan de menor y mayor interés y dificultad , en la identificación 
de los componentes de un sistema de control y su tecnología reconociendo y controlando sus 
reacciones frente a retos y obstáculos 
Identifica el tipo de arquitectura presente en el sistema de control, relacionándola con los 
siguientes aspectos. 

 Sistema de control. 
 

Arquitectura de control básico. 
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Materiales, herramientas, instrumental, 
maquinaria y equipo Desempeños 

 Sistema de control automático de lazo abierto. 
 Sistema de control de lazo cerrado. 
 Sistema de control por computadora o control digital. 

 
Arquitectura de control digital directo 

 

 
 Sistema de control distribuido 



  

 
 ISCC-O2 29/81 

 

Guía Pedagógica y de Evaluación del Módulo: 
Instalación de sistemas de control por computadora

Materiales, herramientas, instrumental, 
maquinaria y equipo Desempeños 

Arquitectura básica de un sistema distribuido. 

 

 
Arquitectura control distribuido 

 

Explica con fundamentos su planteamiento. 
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Materiales, herramientas, instrumental, 
maquinaria y equipo Desempeños 

Sintetiza evidencias obtenidas para producir conclusiones y formular nuevas preguntas al determinar 
el tipo de sistema de control 

 
Elaboración de una maqueta de la arquitectura del sistema de control de la instalación 
visitada. 
5. Describe: 

o El objetivo del sistema de control con base al análisis de la información manejada en 
esta actividad. 

o Los bloques de funciones de un sistema de control en general y de un sistema de control 
por computador en particular. 

o Las variables a controlar en cada bloque de la arquitectura. 
Cultiva relaciones interpersonales que contribuyen a su desarrollo humano y el de quienes lo rodean 
al realizar la maqueta del sistema de control. 
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Unidad de aprendizaje: Mantenimiento preventivo en componentes hardware y software de equipo de 
cómputo. Número: 1 

  

Práctica: Presentación de un caso real de un sistema de control por computador. Número: 2 
  

Propósito de la práctica: Manejar los componentes de un sistema de control por computadora. 
  

Escenario: Taller o laboratorio Duración  5 horas 
 

Materiales, herramientas, instrumental, 
maquinaria y equipo Desempeños 

Material por equipo de trabajo de 4 integrantes: 
 Lápiz 
 1 Computadora de escritorio con procesador de 

texto y software de presentación y puerto serie. 
 Circuito de control de la Fig. 3 armado. 

1. Integra equipos de trabajo de 4 participantes. 
2. Revisa las actividades planeadas del proyecto, cuyo resultado la elaboración de un manual 

de mantenimiento y las relaciona con las actividades de esta práctica. 

3. Aplica las medidas de seguridad e higiene al utilizar equipo energizado. 

Identificación de la configuración hardware. 
4. Identifica los bloques de un sistema de control de actuadores (relevadores o triacs) de 

potencia controlados por una computadora a través del puerto serie. 

5. Identifica la configuración del hardware del sistema que interactúa con el sistema a controlar. 

6. Describe el funcionamiento de la arquitectura de hardware en la generación de las señales 
de control Fig. 1. 

Fig. 1: Sistema de control con actuadores. 
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7. Describe la función de control de cada circuito en el sistema de control, Fig2. 

Fig. 2 Función del control de los circuitos en el sistema de control 

 

8. Identifica la programación del sistema de comunicación del microcontrolador, con los 
actuadores. 

9. Verifica que esté disponible el circuito de la Fig. 3, correspondiente al diagrama a bloques de 
la Fig. 2. 

10. Identifica las señales de control y la forma en que la computadora controla a los actuadores, 
ver circuito eléctrico, Fig. 3. 

Fig. 3 Diagrama a bloques de la Fig. 2 

 

11. Verifica que cuando menos tres relevadores estén conectados a los circuitos que se requiere 
controlar, por ejemplo: motores, luces, artículos electrodomésticos, con la finalidad de operar 
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el sistema de control por computadora. 

12. Identifica las siguientes generalidades operativas:  

o Cada módulo tiene una dirección de 8 bits que lo identifica del resto. Esta dirección está 
guardada en la memoria EEPROM del µC y es posible cambiarla desde el programa que 
corre en la computadora. Utiliza MAX 232 como repetidores por las distancias a las que 
pueden estar los dispositivos a controlar. 

o El puerto RS232 convertido en TTL a través del MAX 232, alimenta al micro por uno de 
los pines del puerto A. Dos pines de este mismo puerto se emplean para censar los 
interruptores. Se utiliza un pin, para permitir al programa de la PC modificar el código del 
módulo. El otro interruptor se puede utilizar para colocar una llave tipo bancaria u otro 
tipo práctico de fines académicos; al activarse abre todos los reles o triacs de la salida 
sin importar el estado en que se encuentren las salidas. Sí el programa le indica al 
módulo encender, las salidas permanecerán en estado apagado hasta que se retire la 
llave de seguridad. La función del LED y el zumbador es para señalización. 

o El puerto B del micro sale hacia un buffer de corriente ULN2803A, que excita las bobinas 
de los relés o los optoacopladores que controlan los triacs.  

o Las cuatro operaciones siguientes se pueden realizar a partir de esta información: 

1. Inicialización del sistema. Todas las salidas de 4 módulos en apagado; enviar por el 
puerto serie la siguiente secuencia: 0Fh FFh F0h.  

2. Control de las salidas de 1 módulo. A través del puerto serie envío las tres palabras 
siguientes: La primera de ellas (F1h) indica que se quieren fijar las salidas del módulo que se 
indica, en la siguiente palabra. Por último, la tercera palabra indica el estado que deben 
adquirir las ocho salidas del módulo. No es más que una carga directa sobre el puerto B del 
dato recibido en la tercera palabra, siempre que la segunda palabra sea la misma que la 
contenida en la EPROM del módulo. Esto es para que solo accione el módulo 
correspondiente. A continuación se muestra la forma del envío de una secuencia para esta 
función: 
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3. Establecer la dirección del módulo: el interruptor de programación en el módulo debe estar 
cerrado. El interruptor es accionado el LED se ilumina y el buzzer produce un breve pitido 
indicando que ha entrado en modo programación. El sistema queda a la espera de dos 
palabras, la primera de ellas indica la función específica de programación (F2h) y la segunda  
indica la dirección que el módulo debe adoptar. Cuando ambas palabras son recibidas el 
módulo guarda en la EPROM el nuevo código de dirección y también hace sonar un pitido 
largo en el buzzer, indicando que la operación terminó con éxito. Luego, el usuario debe abrir 
nuevamente la llave de programación lo cual es indicado con el apagado del LED. Abajo se 
observa cómo es la trama de datos para esta función: 

 

4. Pruebas al módulo. Esto es algo así como hacerle un PING al módulo tras lo cual el 
zumbador, producirá tres breves pitidos al tiempo que destella el LED. No afecta el estado 
de las salidas ni la dirección del módulo. Para que esto suceda habrá que enviar dos 
palabras por el bus. La primera conteniendo el código de la función (F4h) y la segunda 
conteniendo la dirección del módulo, tal como se observa debajo: 

 

La interface RS232 la cual convierte el dato serie entrante al equipo en TTL lo vuelve a 
convertir en RS232 al mismo tiempo a fin de transmitir la señal hacia los siguientes módulos.  

El interruptor indicado como Vel. (ubicado en el panel posterior) permite seleccionar si el 
sistema que funcionará a baja velocidad (2400 bps) o a alta velocidad (9600 bps). Otro 
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interruptor (que también debería estar en el panel posterior) permite colocar el módulo en 
posición de programación. En este estado, el micro espera una palabra por el puerto serie la 
cual será adoptada como dirección del módulo en el bus. Luego de una programación de 
dirección la misma queda retenida en la memoria Flash del micro a fin de no perderla ante 
una desconexión y también se emite un sonido de confirmación. El zumbador posee un 
interruptor para evitar que el mismo emita sonidos. Esto es útil, si el sistema funciona en un 
sitio de ambiente controlado (donde se requiera silencio). El interruptor indicado como “Seg” 
permite desconectar eléctricamente los relés. De esta forma, si se necesita efectuar una 
modificación en las salidas y no se quieren correr riesgos, se podrá hacer 
independientemente del estado que el equipo presente en el bus. El diodo LED marcado 
como “Act” se ilumina cuando el módulo es seleccionado y se apaga cuando se completa la 
operación efectuada sobre el. 

A continuación se observa el diagrama electrónico del circuito completo en la Fig.3, la 
alimentación es a 220 V. 

Fig. 3 Diagrama electrónico, circuito completo 
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Sigue instrucciones y procedimientos de manera reflexiva, comprendiendo como cada uno de 
sus pasos contribuye al alcance de un objetivo 
 
Identificación de la configuración software. 
13. Verifica que esté cargado el firmware del microcontrolador y ejecuta las siguientes 

instrucciones: 

Carga del programa 

;envío de datos del PC al PIC 
;2400 – 8N1 

status equ 3h ;registro de estados del micro 
ptoa equ 5h ;puerto a 
ptob equ 6h ;puerto b 
cfga equ 85h ;registro de config. Puerto a 
cfgb equ 86h ;registro de config. Puerto b 
r0d   equ 0dh ;registros de propósito general 
r0e   equ 0eh 
conta equ 10h 
recep equ 11h ;buffer de entrada 

z equ 2h  ;bandera de zero 
c equ 0h  ;bandera de carry 
p equ 5h  ;bit de selección de pagina 
w equ 0h  ;para almacenar en w 
r equ 1h  ;para almacenar en el mismo registro 
rx equ 2h  ;bit de recepción de datos en serie 

 
 org 00h  ;vector de reset 
 goto inicio  ;salta al comienzo del programa 
 org 05h  ;saltea el vector de interrupción 
 
start movlw .124 ;retardo para generar bit de arranque 
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 goto startup 
delay movlw .83 ;retardo para generar bit de datos 
startup movwF r0e 
redo nop  ;pierde 12 microsegundos 
 nop 
 decfsz r0e  ;resta 1 al retardo   
 goto redo  ;si falta tiempo itera 
 retlw 0  ;si termino retorna limpiando w 
 
recibir nop  ;recibe un byte por RS232 
 clrf recep  ;limpia el buffer de recepción 
 btfss ptoa,rx  ;mira el estado de la línea serie 
 goto recibir  ;si esta inactiva queda a la espera 
 call start  ;retardo para bit de arranque 
rec movlw 8  ;carga cantidad de bits a recibir 
 movwf conta 
rnext bcf status,c ;limpia el carry 
 btfss ptoa,rx  ;mira la línea de recepción 
 bsf status,c ;si esta en alto sube el carry 
 rrf recep  ;rota el buffer de recepción 
 call delay  ;retardo entre bits 
 decfsz conta  ;resta uno a la cantidad de bits a recibir 
 goto rnext  ;si faltan bits por recibir itera 
 retlw 0  ;si termino sale y limpia w 
 
inicio bsf status,p ;selecciona la pagina 1 de memoria 
 movlw 0ffh  ;programa el puerto a como entradas 
 movwf cfga 
 movlw 00h  ;programa el puerto b como salidas 
 movwf cfgb 
 bcf status,p ;selecciona la pagina 0 de memoria 
 clrf recep  ;limpia el buffer de recepción 
 clrf ptob  ;apaga todas las salidas 
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ciclo call recibir  ;queda a la espera de recibir datos 
 movf recep,w  ;carga en w el dato recibido 
 movwf ptob  ;manda el dato a las salidas 
 goto ciclo  ;itera indefinidamente 
 
 end 

14.  Opera el sistema para controlar los mecanismos disponibles en el taller. 

15. Describe el funcionamiento del sistema, identificando las variables de control. 

16. Describe las interfases. 

17. Toma una fotografía al circuito de control terminado, el cual deberá presentarse como el de 
la Fig. 4 

Fig. 4 Circuito terminado 
 

 

Elabora reporte de resultados, describiendo el caso de control. 

Articula saberes de diversos campos y establece relaciones entre ellos y su vida 
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cotidiana al identificar el software del sistema de control. 

 
Presentación de los Resultados 
18. Elabora una presentación en power point, reportando el desarrollo y resultados del caso de 

control por computadora. 

19. Aplica distintas estrategias comunicativas al presentar los resultados a sus compañeros, 
considerando los objetivos que persigue. 
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Unidad de aprendizaje: Instalación de sistemas de control por computadora. Número: 2 
  

Práctica: Presenta la operación de un simulador y los resultados obtenidos.  Número: 3 
  

Propósito de la práctica: Operar los dispositivos de control del sistema por computadora. 
  

Escenario: Taller o laboratorio Duración  6 horas 
  

Materiales, herramientas, instrumental, 
maquinaria y equipo Desempeños 

Material por equipo de trabajo de 4 integrantes: 
 Lápiz 
 1 Computadora de escritorio con procesador de 

texto y software de presentación. 
 LabView instalado en las computadoras a 

utilizar en la práctica. 
 NI-DAQ mx instalado y que soporte los 

dispositivos compatibles con él. 
 Software de comunicación para el control de 

instrumentos de National Instruments.Manual de 
instalación de LabView. 

 Manual de operación de LabView. 

1. Integra equipos de trabajo de 4 participantes: 

2. Aplica las medidas de seguridad e higiene al utilizar equipo energizado y de manejo 
delicado. 

 
Manejo de las funciones a realizar por el sistema de control por computadora. 
Manipula las funciones que realiza un sistema de control por computadora, considerando: 

1. Función: abrir y cerrar un instrumento virtual (VI), Fig. 1: 

Fig. 1: Abrir y cerrar un instrumento virtual 
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 Función Signal Generation and Processing (Generación y Procesamiento de Señales) y lo 
ejecuta.  

 Cambia las frecuencias y tipos de señales de entrada, observando que el display en las 
graficas cambia.  

 Cambia la ventana de procesamiento de señales y las opciones de filtro; examina el VI y las 
diferentes opciones que puede cambiar, detiene el VI presionando el botón de parada (Stop 
button). 

a. Selecciona Start»Programs»National Instruments»LabView 7.0»LabView iniciando 
LabView. Aparece la caja de diálogo de LabView. 

b. Selecciona Help»Find Examples. La caja de diálogo resultante muestra y enlaza todos 
los Vis de ejemplo disponibles en LabView. 

c. Selecciona en Browse Tab, browse (navegar), de acuerdo al tema deseado. Elije 
Analyzing and Processing Signals (analizando y procesando señales), a continuación 
Signal Processing, después Signal Generation and Processing.vi. Como resultado, 
abre el Panel Frontal del VI Signal Generation and Processing, el cual se puede abrir 
también con VI al hacer clic en el botón Open VI (abrir VI) y navegar a 
LabView\examples\apps\demos.llb\Signal Generation and Processing.vi. 

 Registra los resultados a estas acciones y la forma en que se aplican para sistemas 
controlados por computadora. 

Sigue instrucciones y procedimientos de manera reflexiva en el Manejo de las funciones a 
realizar por el sistema de control por computadora, comprendiendo como cada uno de sus pasos 
contribuye al alcance de un objetivo. 

2. Operación del Panel Frontal 

 Describe el panel frontal  

 Selecciona  el botón Run (correr) de la barra de herramientas, mostrado a la izquierda, para 
correr este VI. Este VI determina el resultado de filtrar una señal generada. Este ejemplo 
también muestra el espectro de poder (power spectrum) para señales generadas. Las 
señales resultantes son mostradas en graficas en el panel frontal. 
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 Utiliza la herramienta de Operación, mostrada en la izquierda, para cambiar 
la señal de Entrada y la señal de Procesamiento, usa las flechas de incremento o 
decremento en el control, y mueve el puntero a la Frecuencia deseada. 

Presiona el botón de More Info…(más información) o [F5] para obtener mayor información 
acerca de las funciones de análisis. 

 Presione el botón Stop (parada) o [F4] para parar el VI. 

3. Diagrama de Bloque 

 Selecciona Window»Show Diagram o presiona las teclas <Ctrl-E>, con la finalidad de 
mostrar el diagrama de bloque del VI Signal Generation and Processing. 

En (MacOS) se utilizan las teclas <Command-E>. (Sun)  

En (Linux) se utilizan las teclas <Alt-E>. 

Este diagrama de bloque contiene muchos de los elementos básicos de diagrama de bloque, 
incluyendo subVIs, funciones, y estructuras. 

  Selecciona Window»Show Panel o presiona las teclas <Ctrl-E> para regresar al Panel 
Frontal. 

  Cierra el VI y no guardas los cambios. 

Practica con la Función: convertir C a F 
Construye un instrumento virtual (VI), que convierte una cantidad en 0C a 0F. 

 



  

 
 ISCC-O2 43/81 

 

Guía Pedagógica y de Evaluación del Módulo: 
Instalación de sistemas de control por computadora

Materiales, herramientas, instrumental, 
maquinaria y equipo Desempeños 

 Identifica en las ilustraciones de cableado, la flecha al final del icono del mouse 
(mostrado al lado izquierdo) muestra donde hacer clic, el numero en la flecha indica 
cuantas veces hay presionar el botón. 

 Selecciona File»New para abrir un nuevo panel frontal. 

 Selecciona Window»Tile Left and Right (Opcional), mostrando el panel frontal y el 
diagrama de bloques uno al lado del otro. 

 Crea un control digital numérico. Con la finalidad de convertir temperaturas de 0C a 0F, 
realizando las siguientes actividades. 

 Selecciona el control digital en la paleta de Controls»Numeric Controls. Si la paleta de 
Controls no está visible, presiona clic-derecho en un área abierta del panel frontal para 
desplegarla. 

 Mueve el control al panel frontal y hace clic para colocar el control. 

 Escribe la cantidad en 0C adentro de la etiqueta y presiona clic afuera de la etiqueta o en el 
botón Enter de la barra de herramientas. Sí no se escribe el nombre inmediatamente, 
LabView utiliza una etiqueta que tiene por defecto. Puede editar una etiqueta en cualquier 
momento utilizando la herramienta de Etiquetado. 

 Crea un indicador digital numérico el cual utiliza para mostrar el valor en grados Fahrenheit. 

 Selecciona el indicador digital en la paleta Controls»Numeric Indicators. 

 Mueve el indicador al panel frontal y haga clic para colocar el indicador. 

 Escribe la cantidad en 0F adentro de la etiqueta y hace clic afuera de la etiqueta o en el 
botón Enter. 

 LabView crea las terminales de control e indicación correspondientes en el diagrama de 
bloques. Las terminales representan el tipo de dato de control o indicación. Por ejemplo, una 
terminal DBL representa un control o indicador numérico de punto flotante con valor de 
precisión-doble. 

 Observa que las terminales de control muestran un borde más grueso que las terminales de 
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los indicadores. 

 
Diagrama de Bloque 

 Despliega el diagrama de bloques haciendo clic en Window»Show Diagram. 

 

 Observa  que las terminales del Diagrama de Bloques pueden ser vistas como iconos o como 
terminales. Para cambiar la manera en que LabView despliega estos objetos puede hacer clic 
con el botón derecho del mouse en la terminal y seleccione View As Icon.   

 

 Selecciona las funciones de Multiplicación (Multiply) y Suma (Add) en la paleta de 
Functions»Numeric, colocándolas  en el diagrama de bloques.  

 Selecciona una constante numérica en la paleta Functions»Numeric y coloca dos de ellas 
en el diagrama de bloques, cuando se coloca la constante numérica por primera vez, ésta 
queda seleccionada de manera que se pueda escribir el valor deseado. 

 Asigna los valores de 1.8 en una de las constantes y 32.0 en la otra. Y cablea una terminal 
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con otra, utilizando la herramienta de Cableado, como se muestra en la siguiente ilustración; 
se puede iniciar el cableado desde cualquier terminal. 

 

 Dobla un cable, haciendo clic para sujetar el cable a la pantalla y moviendo el cursor en una 
dirección perpendicular. Presiona la barra de espaciamiento para cambiar la dirección de 
cableado. 

o Identifica terminales en los nodos, haciendo clic derecho en las funciones de 
Multiplicación y Suma y selecciona Visible Items»Terminals desde el menú de 
atajo para desplegar el conector. Regresa a los iconos una vez que haya cableado, 
haciendo clic derecho en las funciones y seleccionando Visible Items»Terminals 
desde el menú de atajo para remover la selección (checkmark). 

o Mueve la herramienta de Cableado sobre una terminal; el área de la terminal se 
ilumina intermitentemente, indicando que al hacer clic sobre ella se conectará el 
cable a la terminal y una etiqueta de sugerencia aparece, mostrando el nombre de 
la terminal. 

o Cancela un cable que se ha comenzado a conectar, presione la tecla <Esc>, 
presiona  clic derecho o haciendo clic en la terminal de inicio. 

 
 Despliega el panel frontal haciendo clic en él o seleccionando Window»Show Panel. 

 Graba el VI ya que se utilizara en otra etapa. 
a. Selecciona File»Save. 
b. Navega c:\exercises\LV Intro. 

i. Graba todos los Vis que edita en este curso en c:\exercises\LV Intro. 
a. Escribe Convertir C a F.vi en el ventana de dialogo. 
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b. Haz clic en el botón Save. 

ii. Ingresa un número en el control digital y ejecuta el VI. 
a. Utiliza la herramienta de Operación o la herramienta de Etiquetado para 

hacer doble clic en el control digital y escribir un nuevo número (valor). 
c. Haz clic en el botón de Run para correr el VI. 
d. Utiliza 5 diferentes valores y ejecuta el VI otra vez. 

iii. Selecciona File»Close para cerrar el VI Convertir C a F. 

Fin de la práctica Construir un instrumento virtual (VI), que convierte una cantidad en 0C a 
0F 

 
 Creación de un SubVI 
1. Panel Frontal 

 Selecciona File»Open y navega a c:\exercises\LV,abre el VI Convertir C a F. 

 Verifica si los Vis están abiertos, en caso contrario haz clic en el botón Open… en la ventana 
de dialogo de LabView 

 Practica la siguiente alternativa, haciendo clic en la flecha junto al botón Open… en la 
ventana de dialogo de  LabView para abrir documentos recientemente abiertos, tales como 
Convertir C a F.VI., apareciendo el panel frontal. 

 Presiona clic derecho en el icono en la parte superior derecha del panel frontal y selecciona 
Edit Icon del menú de atajo, esto hace que aparezca la ventana de dialogo Icon Editor. 

 Presiona doble clic en la herramienta de Selección en la parte izquierda de la ventana de 
dialogo del Icon Editor para seleccionar el icono por defecto. 

 Presiona la tecla <Delete> para remover el icono por defecto. 

 Presiona doble clic en la herramienta de Rectángulo para re-dibujar la orilla. 
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 Crea el siguiente icono. 

 

a. Utiliza la herramienta de Texto para hacer clic en el área de edición, escribiendo C y F. 

b. Hace doble clic en la herramienta de Texto y cambia el tamaño de la letra (fuente) a 
Small Fonts. 

c. Utiliza la herramienta de Lápiz para crear una flecha. 

d. Para dibujar líneas rectas horizontales o verticales presiona la tecla <Shift> mientras 
se utiliza la herramienta de Lápiz para mover el cursor. 

e. Utiliza la herramienta de Selección y las teclas de flecha (arrow keys) para mover el 
texto y la flecha que se creo. 

f. Selecciona el icono B&W y selecciona 256 Colors en el campo Copy from para crear 
un icono en blanco y negro, el cual LabView utiliza para imprimir 

g. Verifica que el icono esté completo, con un clic en el botón OK para cerrar la ventana 
de dialogo Icon Editor. El icono aparece en la esquina superior derecha del panel 
frontal y del diagrama de bloque. 

h. Presiona clic derecho en el icono localizado en el panel frontal y selecciona Show 
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Connector desde el menú de atajo para definir el patrón de terminales del conector.  
LabView selecciona un patrón para el conector basado en el número de controles e 
indicadores en el panel frontal. Por ejemplo, este panel frontal tiene dos terminales, 
deg C y deg F, por lo que LabView selecciona un patrón de conector con dos 
terminales. 

i.    Asigna las terminales al control digital y al indicador digital. 
o Selecciona Help»Show Context Help para desplegar la ventana Context 

Help. Mire cada conexión en la ventana Context Help mientras usted las 
hace. 

o La herramienta automáticamente se cambia a la herramienta de Cableado, y 
la terminal se torna negra. 

o Presiona clic en el control deg C. La terminal izquierda se torna naranja y el 
control se remarca. 

o Pulsa clic en un área desocupada del panel frontal. El remarcado 
desaparece, y la terminal se cambia al color del tipo de dato del control para 
indicar que se ha conectado la terminal. 

o Presiona clic en la terminal derecha del conector y haga clic en el indicador 
deg F. La terminal derecha se torna naranja. 

o Presiona clic en un área desocupada del panel frontal. Ambas terminales son 
color naranja. 

o Mueve el cursor sobre el conector. La ventana de Context Help muestra que 
ambas terminales están conectadas a valores de punto flotante. 

j.     Selecciona File»Save para salvar el VI porque usted usara este VI más adelante en el 
curso. 

k. Selecciona File»Close para cerrar el VI Convertir C a F. 
Identifica los sistemas y reglas o principios medulares que subyacen a la operación del panel 
frontal y sub VI. 
Elaboración del reporte de operación del simulador. 
1. Describe los instrumentos virtuales (VI) y la aplicación que tienen en los sistemas de control 

por computadora. 

2. Describe los tres componentes de los instrumentos virtuales. 
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3. Explica la función, operación y aplicación de: panel frontal, diagrama de bloques, íconos y 
conector de la sección 

4. Elabora y registra conclusiones sobre el tema. 

5. Elige las fuentes de información más relevantes para la elaboración del reporte de operación 
del simulador y discrimina entre ellas de acuerdo a su relevancia y confiabilidad. 
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Unidad de aprendizaje: Instalación de sistemas de control por computadora. Número: 2 
  

Práctica: Identifica las funciones de LabView. Número: 4 
  

Propósito de la práctica: Operar los componentes de interfase de la computadora con las facilidades de los sistemas de control por computadora. 
  

Escenario: Taller o laboratorio Duración  5 horas 
  

Materiales, herramientas, instrumental, 
maquinaria y equipo Desempeños 

Material por equipo de trabajo de 4 
integrantes: 
 Lápiz 
 1 Computadora de escritorio con 

procesador de texto y software de 
presentación. 

 LabView instalado en las computadoras 
a utilizar en la práctica. 

 NI-DAQmx instalado y que soporte los 
dispositivos compatibles con él. 

 Software de comunicación para el 
control de instrumentos de National 
Instruments. 

1. Integra equipos de trabajo de 4 participantes. 

Aplica las medidas de seguridad e higiene al utilizar equipo energizado y de manejo delicado en el 
desarrollo de la práctica. 

2. Prepara el equipo, instrumentos e información para la práctica. 

 

Identificación de las técnicas de interfase entre el computador, los dispositivos de control y el 
sistema a controlar 
 
Opera la interfase entre el computador, los dispositivos de control y el sistema a controlar 

Construcción y ejecución de un instrumento virtual. 
3. Identifica la construcción de un instrumento como el que aparece en la pantalla de la figura 1. 

4. Identifica las plantillas que LabView proporciona con información a partir de la cual se puede 
construir el VI. Estas plantillas ayudan a empezar con LabView. Completa los pasos posteriores para 
crear un VI que genere una señal y la despliegue en el panel frontal. 

5.  Abre la aplicación de LabView. Presiona clic en el botón de diálogo de LabView, mostrado en la 
Fig.2, sobre el botón New para desplegar el nuevo botón de diálogo. 

6. Selecciona VI from Template»Tutorial (Getting Started)»Generate and Display de la lista Create new. 
Esta plantilla de VI genera y despliega una señal. 
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Fig. 1 Panel frontal de un VI para la 
adquisición de una señal. 

Fig. 2 Botón de dialogo LabView 

 

Observa que una vista preliminar de la plantilla VI aparece en las secciones de Front Panel review 
y Block Diagram Preview. La Fig.3 muestra el nuevo botón de diálogo y la plantilla Generate and 
Display de VI. 

Fig. 3. Botón de diálogo New. 

 

7. Presiona el botón de OK para abrir la plantilla. 
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8. Examina el panel frontal del VI. La interfase del usuario o panel frontal, aparece con un fondo en 
color gris e incluye controles e indicadores. La barra de título del panel frontal indica que esta 
ventana es el panel frontal para el VI Generate and Display. Si el panel frontal no es visible, puede 
desplegarlo al seleccionar Window»Show Front Panel. 

9. Examina el diagrama de bloques del VI. El diagrama de bloques aparece con un fondo blanco e 
incluye VI y estructuras que controlan los objetos del panel frontal. La barra de titulo del diagrama de 
bloques indica que esta ventana es el diagrama de bloques para el VI Generate and Display. 

Nota: Si el panel frontal no es visible, puede desplegarlo al seleccionar Window»Show Block 
Diagram. 

10. Presiona clic en el panel frontal de la barra de herramientas, en el botón Run, que se ubica de lado 
izquierdo. Observa que una onda senoidal aparece en la gráfica. 

11. Para el VI con clic en el botón STOP, que se muestra a la izquierda, de panel frontal  

 
Agrega un control (dispositivo) al panel frontal. 
Verifica que la paleta Controls, mostrada en la Fig.4, es visible en el panel frontal, sí no lo es, 
selecciona Window»Show Controls Palette para mostrarla. 

Fig. 4. Paleta de controles 
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12. Mueve el cursor sobre los íconos de la paleta Controls para localizar la paleta Numeric Controls. 

13. Observa que cuando mueve el cursor sobre los íconos en la paleta Controls, el nombre de la 
subpaleta aparece en el espacio gris sobre los íconos de la paleta. Cuando mantiene el cursor sobre 
cualquier ícono de la paleta, aparece el nombre completo de la subpaleta, control o indicador. 

14. Da clic sobre el ícono Numeric Controls para acceder a la paleta Numeric Controls. 

15. Selecciona la perilla (Dial) de control en la paleta Numeric Controls y posiciónela en el panel frontal 
a la izquierda de la gráfica de forma de onda. Utilizara este botón para en un ejercicio posterior, con 
la finalidad de controlar la amplitud de señal. 

16. Selecciona File»Save As y guarda este VI como Acquiring a Signal.vi, el debe estar en una 
localización accesible. 

Unión de  objetos en el diagrama a bloques. 

17. Mueve el cursor sobre la terminal Knob, hasta que aparezca la Herramienta de Posición. Observa 
cómo el cursor se convierte en flecha o la herramienta de posición que se muestra a la izquierda.  

18. Utiliza la Herramienta de Posición para seleccionar, posicionar y ajustar tamaño de objetos. Da un 
clic en la terminal Knob para seleccionarla, después arrastra la terminal hacia la izquierda del 
Simulate Signal Express VI.  

19. Asegura que la terminal Knob se encuentre dentro del recuadro que se muestra a mano izquierda. 
La terminal son representaciones de los controles e indicadores del panel frontal. Las terminales son 
puertos de entrada y salida que intercambian información entre el panel frontal y el diagrama de 
bloques. 

20. Quita la selección de la terminal Knob dando un clic en el espacio en blanco en el diagrama de 
bloques. 

21. Mueve el cursor sobre la flecha de la terminal Knob, mostrada a la izquierda. Observa cómo el 
cursor se torna en una bobina de unión o la Herramienta de Cableado, mostrada a la izquierda.  

22. Utiliza la Herramienta de Cableado para enlazar objetos en el diagrama de bloques. Observa el 
cursor no se torna en otra herramienta mientras otro objeto este seleccionado. 

23. Presiona clic en la flecha cuando la Herramienta de Cableado aparezca, a continuación dar clic en la 
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entrada Amplitude del Simulate Signal Express VI, que se muestra a la izquierda, para unir dos 
objetos. Observa que aparece un cable y conecta los dos objetos. Los datos fluyen a través de este 
cable de la terminal al VI Express. 

24. Selecciona File»Save para guardar este VI. 

Ejecución del instrumento virtual (VI). 
25. Despliega en el panel frontal seleccionando Window»Show Front Panel o haciendo un clic en el 

panel frontal.  

26. Presiona el botón Run. 

27. Mueve el cursor sobre la perilla de control. Observa cómo el cursor se convierte en una mano, o 
Herramienta de Operación, mostrada a la izquierda.  

28. Utiliza la Herramienta de Operación para cambiar el valor de un control o seleccionar el texto dentro 
del control. 

29. Gira la perilla para ajustar la amplitud para la onda dientes de sierra, usando la Herramienta de 
Operación. Observa cómo la amplitud de la onda dientes de sierra cambia al ir girando la perilla. 
Nótese también que el eje de las “y” en la gráfica ajusta su escala de acuerdo al cambio en amplitud. 

30. Identifica que el VI está corriendo, observando que el botón Run cambia a una flecha obscura, 
mostrada a la izquierda. No se puede editar el panel frontal ni el diagrama de bloques mientras el VI 
esté ejecutándose.  

31. Presiona el botón STOP, mostrado a su izquierda, para detener el VI.  Aunque el botón Abort 
Execution parece el botón STOP, el botón Abort Execution no siempre cierra apropiadamente el VI. 
National Instruments recomienda detener el VI utilizando el botón STOP del panel frontal. Utiliza el 
botón Abort Execution solamente cuando ocurran errores que le impidan detener la aplicación con el 
botón STOP.  

Sigue las instrucciones y el procedimiento de construcción y ejecución de un instrumento virtual en 
LabView. 
Adquisición de datos y comunicación con instrumentos virtuales. 

32. Verifica que esté instalado el NI-DAQmx y un dispositivo soportado por NI-DAQmx, confirma en la 
página Web de National Instruments ni.com/daq para contar la lista de dispositivos suportados port 
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NI-DAQmx, hace referencia al y LabView Measurements Manual para tener información respecto al 
uso del NI-DAQ tradicional para adquisición de datos.  

33. Identifica que en NI-DAQmx, una tarea, es una colección de uno o más canales, tiempos, disparos, y 
otras propiedades que aplican a la tarea por sí  

34. Realiza el siguiente proceso en la creación y configuración de una tarea desde un dispositivo NI-
DAQmx que lea un nivel de voltaje. Abre un nuevo VI,  

35. Selecciona el DAQ Assistant Express VI, que se muestra a la izquierda, en la paleta Input y colócalo 
en el diagrama de bloques. El asistente DAQ Assistant se inicia y aparece la ventana de diálogo 
Create New. 

36. Haz clic en el botón Analog Input para desplegar las opciones del Analog Input. 

37. Selecciona Voltage para crear una tarea de entrada de voltaje análogo. La ventana de diálogo 
despliega una lista de canales de cada dispositivo DAQ instalado. El número de canales  enlistado 
depende del número de canales que se tenga en el dispositivo DAQ. 

38. Selecciona el canal físico en el listado del recuadro My Physical Channels, al cual está conectado la 
señal, como ai0, y después presiona el botón Finish. El Assistant abre una nueva ventana, mostrada 
en la Fig. 5, la cual despliega opciones para la configuración del canal que seleccionaste para 
completar la tarea. 

Fig. 5.Opciones para la configuración del canal 
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39. Escribe 10 para el valor Max y escribe -10 para el valor Min, en la sección Input Range de la pestaña 
Settings. 

40. Selecciona la opción Acquire N Samples, en la pestaña Task Timing. 

41. Escribe el valor de 1000 en el recuadro de entrada Samples To Read. 

 
Comunicación con un instrumento. 

42. Utiliza software de comunicación para el control de un instrumento, verifica en NI Instrument Driver 
Network, ubicado en ni.com/idnet que el software de comunicación para el instrumento, es el que se 
requiere. 

43. Utiliza, el Instrument I/O Assistant Express VI, en caso contingente que no se cumpla el punto 
anterior, para comunicarse con el instrumento. 

44. Verifica que ha encendido el instrumento que quiere usar. El instrumento debe estar conectado para 
utilizar el Instrument I/O Assistant Express VI. 

45. Selecciona el Instrument I/O Assistant Express VI de la paleta Input y colócalo en el diagrama de 
bloques. Da clic en el botón Show Help, que se muestra a la izquierda, en la parte superior derecha 
de la ventana de diálogo del Instrument I/O Assistant. Observa cómo el botón Show Help despliega 
la ayuda a la derecha de la ventana de diálogo. La ventana de ayuda en la parte superior contiene 
información de procedimiento de uso del Instrument I/O Assistant. La ventana de ayuda en la parte 
inferior proporciona ayuda de contexto acerca de varios controles e indicadores del botón de 
diálogo. 

46. Sigue los procedimientos en la ventana de ayuda superior seleccionando el instrumento con el cual 
se requiere la comunicación. Configura las propiedades del instrumento sí se requiere. 

47. Presiona clic en el botón Hide Help, que se muestra a la izquierda, en la esquina superior derecha 
de la ventana de diálogo Instrument I/O Assistant para minimizar la ventana de ayuda. 

 
Identificación de los componentes de interfase. 

48. Identifica en las actividades de esta práctica, en donde se operan los componentes de interfase, 
cuales son y como están operando. 
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49. Profundiza en el manual, sobre la operación de los componentes de interfase, mencionando otros 
que no se hayan manejado en esta práctica. 

50. Utiliza otros componentes de interfase que haya identificado y que no se hayan utilizado. 

51. Opera cuando menos dos componentes de interfase diferentes. 

52. Reconoce los propios prejuicios, modifica sus puntos de vista al conocer nuevas evidencias, e 
integra nuevos conocimientos y perspectivas al acervo con el que cuenta al realizar funciones de 
control. 

 
Presentación de la operación del simulador. 
53. Describe las funciones que realiza LabView. 

54. Muestra la operación de la funciones del LabView. 

55. Describe las interfases utilizadas en la práctica y su interpretación. 

56. Asume una actitud constructiva, congruente con los conocimientos y habilidades con los que cuenta 
dentro de distintos equipos de trabajo. 
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Unidad de aprendizaje: Instalación de sistemas de control por computadora. Número: 2 
  

Práctica: Instala LabView y lo opera. Número: 5 
  

Propósito de la práctica: Instalar los diferentes componentes físicos y lógicos de un sistema de control por computadora, respetando las 
recomendaciones de diseño técnico de los fabricantes y especialistas. 

  

Escenario: Taller o laboratorio Duración  5 horas 
 

Materiales, herramientas, instrumental, 
maquinaria y equipo Desempeños 

Material por equipo de trabajo de 4 integrantes:
 Lápiz 
 1 Computadora de escritorio con 

procesador de texto y software de 
presentación. 

 1 laptop con sistema operativo Windows. 
 1 laptop Apple. 
 1 ratón 
 Papel para registro de información. 
 Conexión a internet de banda ancha, 

mínimo de 2 Mb. 
 Cámara fotográfica. 
 Utilerías de diagnóstico y mantenimiento. 
 Utilerías del equipo. 
 Manuales y documentación técnica del 

equipo. 
 Utilería Vortex para diagnóstico de 

problemas de hardware o similar. 
 

Material por equipo de trabajo de 4 integrantes:
 Lápiz 
 1 Computadora de escritorio con 

procesador de texto y software de 

1. Integra equipos de trabajo de 4 participantes. 

2. Revisa las actividades planeadas del proyecto, cuyo resultado la elaboración de un manual de 
mantenimiento y las relaciona con las actividades de esta práctica. 

3. Aplica las medidas de seguridad e higiene al utilizar equipo energizado y de manejo delicado 
en el desarrollo de la práctica. 

Instalación de LabView. 

4. Ejecuta el archivo LabView_86_E.exe o la versión disponible. 

Instalación de LabView 
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presentación. 
 LabView instalado en las computadoras a 

utilizar en la práctica. 
 NI-DAQmx instalado y que soporte los 

dispositivos compatibles con él. 
Software de comunicación para el control 
de instrumentos de National Instruments. 

Instalación de LabView 

 

5.  Ejecutar el paquete de cracks, y busca el “PRINCIPAL – NI.LabViewv8.6”. 

Instalación de LabView 
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6.  Extrae la carpeta y ejecuta el archivo “keygen.exe” para generar el serial y el archivo de licencia. 
Al ejecutarlo aparecerá la siguiente ventana. 

Instalación de LabView 

 

7. Genera el serial, seleccionando el tipo de licencia que se desee, ejemplo seleccionamos la 
“Professional Development System with MathScript”, luego da click en “Generate”. 

Instalación de LabView 
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8. Genera el archivo de licencia dando click en “Create license file”, guárdalo con cualquier nombre 
en un lugar que identifiques fácilmente, ya que se requerirá en el futuro. 

Instalación de LabView 

 

9. Confirma que se guardó el archivo de licencia y pega el número de serie. 
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Instalación de LabView 

 

10. Verifica que concluya el proceso de instalación, cuando ocurra esto, no iniciar LabView. 

11. Copia el archivo de licencia a la carpeta donde quedó instalado, ejemplo, buscar 

C:\Archivos de programa\National Instruments\Shared\License Manager\Licenses 

12. Pega el archivo de licencia. Arranca LabView. 

13. Se familiariza con los tutoriales, ejemplo: 
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Instalación de LabView 

 

Utiliza las tecnologías de la información y comunicación para procesar e interpretar información 
relativa a la Instalación de LabView. 

14. Revisa el sistema controlado por computadora de la práctica N° 3. 

15. Selecciona un ejemplo de la plantillas de ejemplo con los que cuenta LabView, con la finalidad de 
elaborar un propuesta de sistema controlado por computadora. 
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Help»Find Examples 

16. Identifica, si existe un modelo de control, igual o similar al solicitado. 

17. Decide si modifica el ejemplo o lo adoptas como está, justificando la decisión tomada. 

18. Desarrollo la propuesta y la presenta al docente. 

19. Sintetiza evidencias obtenidas mediante la experimentación para producir conclusiones y formular 
nuevas preguntas al instalar LabView 

 
Elaboración de reporte y presentación de las funciones. 
20. Describe el proceso de selección del ejemplo y de desarrollo del modelo de control. 

21. Demuestra la operación de LabView. 

22. Plasma sus conclusiones en el reporte y las comparte con sus compañeros de clase. 
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II. Guía de evaluación del módulo
Instalación de sistemas de control por computadora
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7. Descripción  

La guía de evaluación es un documento que define el proceso de recolección y valoración de las evidencias requeridas por el módulo desarrollado y 
tiene el propósito de guía en la evaluación de las competencias adquiridas por los alumnos, asociadas a los Resultados de Aprendizaje; en donde 
además, describe las técnicas y los instrumentos a utiliza y la ponderación de cada actividad de evaluación. Los Resultados de Aprendizaje se definen 
tomando como referentes: las competencias genéricas que va adquiriendo el alumno para desempeñase en los ámbitos personal y profesional que le 
permitan convivir de manera amónica con el medio ambiente y la sociedad; las disciplinares, esenciales para que los alumnos puedan desempeñase 
eficazmente en diversos ámbitos, desarrolladas en torno a áreas del conocimiento y las profesionales que le permitan un desempeño eficiente, 
autónomo, flexible y responsable de su ejercicio profesional y de actividades laborales específicas, en un entorno cambiante que exige la 
multifuncionalidad.  

La importancia de la evaluación de competencias, bajo un enfoque de mejora continua, reside en que es un proceso por medio del cual se obtienen y 
analizan las evidencias del desempeño de un alumno con base en la guía de evaluación y rúbrica, para emitir un juicio que conduzca a toma decisiones. 

La evaluación de competencias se centra en el desempeño real de los alumnos, soportado por evidencias válidas y confiables frente al referente que es 
la guía de evaluación, la cual, en el caso de competencias profesionales, está asociada con una norma técnica de competencia laboral (NTCL), de 
institución educativa o bien, una normalización específica de un sector o área y no en contenidos y/o potencialidades.  

El Modelo de Evaluación se caracteriza porque es Confiable (que aplica el mismo juicio para todos los alumnos), Integral (involucra las dimensiones 
intelectual, social, afectiva, motriz y axiológica), Participativa (incluye autoevaluación, coevaluación y heteroevaluación), Transparente (congruente con 
los aprendizajes requeridos por la competencia), Válida (las evidencias deben corresponder a la guía de evaluación). 

Evaluación de los Aprendizajes. 
Durante el proceso de enseñanza – aprendizaje es importante considera tres categorías de evaluación: diagnóstica, formativa y sumativa. 

La evaluación diagnóstica nos permite establecer un punto de partida fundamentado en la detección de la situación en la que se encuentran nuestros 
alumnos. Permite también establecer vínculos socio-afectivos entre el docente y su grupo. El alumno a su vez podrá obtener información sobre los 
aspectos donde deberá hacer énfasis en su dedicación. El docente podrá identificar las características del grupo y orientar adecuadamente sus 
estrategias. En esta etapa pueden utilizase mecanismos informales de recopilación de información. 

La evaluación formativa se realiza durante todo el proceso de aprendizaje del alumno, en forma constante, ya sea al finaliza cada actividad de 
aprendizaje o en la integración de varias de éstas. Tiene como finalidad informa a los alumnos de sus avances con respecto a los aprendizajes que 
deben alcanza y advertirle sobre dónde y en qué aspectos tiene debilidades o dificultades para poder regula sus procesos. Aquí se admiten errores, se 
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Identifican y se corrigen; es factible trabaja colaborativamente. Asimismo, el docente puede asumir nuevas estrategias que contribuyan a mejorar los 
resultados del grupo. 

Finalmente, la evaluación sumativa es adoptada básicamente por una función social, ya que mediante ella se asume una acreditación, una promoción, 
un fracaso escolar, índices de deserción, etc., a través de criterios estandarizados y bien definidos. Las evidencias se elaboran en forma individual, 
puesto que se está asignando, convencionalmente, un criterio o valor. Manifiesta la síntesis de los logros obtenidos por ciclo o período escolar. 

Heteroevaluación, Coevaluación y Autoevaluación 
En esta nueva versión (02) de la guía de evaluación se están incluyendo de manera formal tres modalidades de evaluación, que según la persona que 
evalúa se denominan: heteroevaluación, coevaluación y autoevaluación. 

La heteroevaluación: Es aquella que se realiza por personas externas al grupo escolar: representantes del sector productivo, docentes ajenos al grupo 
o cualquier otra persona o grupo colegiado con el dominio suficiente de la competencia, desempeño o producto que se pretenda evaluar. La 
heteroevaluación permite: 

 Demostrar que el alumno adquirió la competencia a evaluar, en diversos contextos y ante cualquier persona o instancia evaluadora.  

 Evidenciar ante agentes no integrantes del proceso enseñanza-aprendizaje las competencias desarrolladas, otorgando cierta objetividad a la 
evaluación. 

 La coevaluación se llevará a cabo entre pares de alumnos, pudiendo ser el evaluador un alumno o grupo de alumnos; es decir, evaluadores y 
evaluados intercambian su papel alternativamente. La coevaluación permite al alumno y al docente: 

 Identificar los logros personales y grupales. 

 Fomentar la participación, reflexión y crítica constructiva ante situaciones de aprendizaje. 

 Mejorar la responsabilidad individual y de grupo. 

 Emitir juicios valorativos acerca de otros en un ambiente de libertad, compromiso y respeto. 

La autoevaluación se refiere a la valoración que hace el alumno sobre su propia actuación o desempeño  y se refiere al grado de dominio de una 
competencia o resultado de aprendizaje alcanzado por él mismo. Le permite al alumno: 

Reconocer sus posibilidades y limitaciones, así como definir las acciones necesarias para mejorar su aprendizaje. 

Actividades de Evaluación 
Los programas de estudio están conformados por Unidades de Aprendizaje (UA) que agrupan Resultados de Aprendizaje (RA) vinculados 
estrechamente y que requieren irse desarrollando paulatinamente. Dado que se establece un resultado, es necesario comprobar que efectivamente éste 
se ha alcanzado, de tal suerte que en la descripción de cada unidad se han definido las actividades de evaluación indispensables para evaluar los 
aprendizajes de cada uno de los RA que conforman las unidades. 
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Esto no implica que no se puedan desarrollar y evaluar otras actividades planteadas por el docente, pero es importante no confundir con las actividades 
de aprendizaje que realiza constantemente el alumno para contribuir a que logre su aprendizaje y que, aunque se evalúen con fines formativos, no se 
registran formalmente en el Sistema de Administración Escolar SAE. El registro formal procede sólo para las actividades descritas en los programas 
y planes de evaluación. 

De esta manera, los RA tienen asignada una actividad de evaluación, considerando que puede haber casos en que se incluirán dos o más RA en una 
sola actividad de evaluación, cuando ésta sea integradora; misma a la que se le ha determinado una ponderación con respecto a la Unidad a la cual 
pertenece. Ésta a su vez, tiene una ponderación que, sumada con el resto de Unidades, conforma el 100%. Es decir, para considera que se ha 
adquirido la competencia correspondiente al módulo de que se trate, deberá ir acumulando dichos porcentajes a lo largo del período para esta en 
condiciones de acredita el mismo. Cada una de estas ponderaciones dependerá de la relevancia que tenga la AE con respecto al RA y éste a su vez, con 
respecto a la Unidad de Aprendizaje. Estas ponderaciones las asignará el especialista diseñador del programa de estudios. 

La ponderación que se asigna en cada una de las actividades queda asimismo establecida en la Tabla de ponderación, la cual está desarrollada en 
una hoja de cálculo que permite, tanto al alumno como al docente, ir observando y calculando los avances en términos de porcentaje, que se van 
alcanzando (ver apartado 8 de esta guía).  

Esta tabla de ponderación contiene los Resultados de Aprendizaje y las Unidades a las cuales pertenecen. Asimismo indica, en la columna de 
actividades de evaluación, la codificación asignada a ésta desde el programa de estudios y que a su vez queda vinculada al Sistema de Evaluación 
Escolar SAE. Las columnas de aspectos a evalúa, corresponden al tipo de aprendizaje que se evalúa: C = conceptual; P = Procedimental y A = 
Actitudinal. Las siguientes tres columnas indican, en términos de porcentaje: la primera el peso específico asignado desde el programa de estudios 
para esa actividad; la segunda, peso logrado, es el nivel que el alumno alcanzó con base en las evidencias o desempeños demostrados; la tercera, 
peso acumulado, se refiere a la suma de los porcentajes alcanzados en las diversas actividades de evaluación y que deberá acumula a lo lago del ciclo 
escolar. 

Otro elemento que complementa a la matriz de ponderación es la rúbrica o matriz de valoración, que establece los indicadores y criterios a 
considera para evalua, ya sea un producto, un desempeño o una actitud y la cual se explicará a continuación. 

Una matriz de valoración o rúbrica es, como su nombre lo indica, una matriz de doble entrada en la cual se establecen, por un lado, los indicadores o 
aspectos específicos que se deben toma en cuenta como mínimo indispensable para evalúa si se ha logrado el resultado de aprendizaje esperado y, 
por otro, los criterios o niveles de calidad o satisfacción alcanzados. En las celdas centrales se describen los criterios que se van a utiliza para evalúa 
esos indicadores, explicando cuáles son las características de cada uno. 

Los criterios que se han establecido son: Excelente, en el cual, además de cumplir con los estándares o requisitos establecidos como necesarios en el 
logro del  producto o desempeño, es propositivo, demuestra iniciativa y creatividad, o que va más allá de lo que se le solicita como mínimo, aportando 
elementos adicionales en pro del indicador; Suficiente, si cumple con los estándares o requisitos establecidos como necesarios para demostrar que se 
ha desempeñado adecuadamente en la actividad o elaboración del producto. Es en este nivel en el que podemos decir que se ha adquirido la 
competencia. Insuficiente, para cuando no cumple con los estándares o requisitos mínimos establecidos para el desempeño o producto. 
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Evaluación mediante la matriz de valoración o rúbrica 
Un punto medula en esta metodología es que al alumno se le proporcione el Plan de evaluación, integrado por la Tabla de ponderación y las 
Rúbricas, con el fin de que pueda conocer qué se le va a solicita y cuáles serán las características y niveles de calidad que deberá cumplir para 
demostrar que ha logrado los resultados de aprendizaje esperados. Asimismo, él tiene la posibilidad de autorregular su tiempo y esfuerzo para recupera 
los aprendizajes no logrados. 

Como se plantea en los programas de estudio, en una sesión de clase previa a finaliza la unidad, el docente debe hacer una sesión de 
recapitulación con sus alumnos con el propósito de valora si se lograron los resultados esperados; con esto se pretende que el alumno tenga la 
oportunidad, en caso de no lograrlos, de rehacer su evidencia, realiza actividades adicionales o repetir su desempeño nuevamente, con el fin de 
recuperase de inmediato y no espera hasta que finalice el ciclo escolar acumulando deficiencias que lo pudiesen lleva a no logra finalmente la 
competencia del módulo y, por ende, no aprobarlo. 

La matriz de valoración o rúbrica tiene asignadas a su vez valoraciones para cada indicador a evalúa, con lo que el docente tendrá los elementos para 
evalúa objetivamente los productos o desempeños de sus alumnos. Dichas valoraciones están también vinculadas al SAE y a la matriz de ponderación. 
Cabe señala que el docente no tendrá que realizar operaciones matemáticas para el registro de los resultados de sus alumnos, simplemente 
deberá marcar en cada celda de la rúbrica aquélla que más se acerca a lo que realizó el alumno, ya sea en una hoja de cálculo que emite el SAE o bien, 
a través de la Web. 
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8. Tabla de ponderación  

 

UNIDAD RA ACTIVIDAD DE 
EVALUACIÓN 

ASPECTOS A EVALUAR % Peso 
Específico 

% Peso 
Logrado 

% Peso 
Acumulado C P A 

1. Identificación 
de los 
componentes 
de sistemas 
de control por 
computadora. 

1.1 Identifica los fundamentos de los sistemas de control en 
general y por computadora.        

1.2  Maneja las arquitecturas de los sistemas de control más 
representativos. 1.2.1 ▲ ▲ ▲ 20%   

1.3 Maneja los tipos de control que se pueden presentar en 
un sistema.        

1.4 Maneja los componentes de un sistema de control por 
computadora. 1.4.1 ▲ ▲ ▲ 20%   

% PESO PARA LA UNIDAD 40%   

2 Instalación de 
sistemas de 
control por 
computadora. 

2.1 Opera los dispositivos de control del sistema por 
computadora. 2.1.1 ▲ ▲ ▲ 20%   

2.2 Opera los componentes de interfase de la computadora 
con las facilidades de los sistemas de control por 
computadora. 

2.2.1 ▲ ▲ ▲ 20%   

2.3 Instala los diferentes componentes físicos y lógicos de un 
sistema de control por computadora, respetando las 
recomendaciones de diseño técnico de los fabricantes y 
especialistas 

2.3.1 ▲ ▲ ▲ 20%   

% PESO PARA LA UNIDAD 60%   
PESO TOTAL DEL MÓDULO 100%   
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9. Materiales para el 
desarrollo de actividades 
de evaluación 
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10. Matriz de valoración ó 
rúbrica  

MATRIZ DE VALORACIÓN O RÚBRICA 

Siglema:  ISCC Nombre del 
módulo: 

Instalación de sistemas de control por 
computadora. 

Nombre del 
alumno:   

Docente evaluador:  Grupo:  Fecha:  

Resultado de 
aprendizaje: 

1.2 Maneja las arquitecturas de los sistemas de 
control más representativos. 

Actividad de 
evaluación:  

1.2.1 Elabora una maqueta con la arquitectura de un 
sistema de control por computadora, simulando una 
instalación real. 

 

INDICADORES % C  R  I  T  E  R  I  O  S 
Excelente Suficiente Insuficiente 

Identificación de los 
componentes y su 
tecnología. 

30% 

Identifica la arquitectura del 
sistema de control, control 
automático de lazo abierto, de lazo 
cerrado, por computadora y 
distribuido, explicando su 
planteamiento. 

Identifica la tecnología utilizada en 
el sistema de control por 
computadora, las unidades 
convencionales, los sistemas 
modulares y los sistemas de 
control distribuido. 

Reconoce las actividades que le 
resultan de menor y mayor interés 
y dificultad, en la identificación de 
los componentes de un sistema de 

Identifica la arquitectura del 
sistema de control, control 
automático de lazo abierto, de lazo 
cerrado, por computadora y 
distribuido, explicando su 
planteamiento. 

Identifica la tecnología utilizada en 
el sistema de control por 
computadora, las unidades 
convencionales, los sistemas 
modulares y los sistemas de 
control distribuido. 

Omite alguna de las siguientes 
actividades: 

 Identificar la arquitectura del 
sistema de control, control 
automático de lazo abierto, de 
lazo cerrado, por 
computadora, y distribuido, 
explicando su planteamiento. 

 Identificar la tecnología 
utilizada en el sistema de 
control por computadora, las 
unidades convencionales, los 
sistemas modulares y los 
sistemas de control distribuido. 
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INDICADORES % C  R  I  T  E  R  I  O  S 
Excelente Suficiente Insuficiente 

control y su tecnología. Asimismo, 
reconoce y controla sus reacciones 
frente a retos y obstáculos. 

Identificación del tipo de 
arquitectura presente en el 
sistema de control 

30% 

Identifica el tipo de sistema de 
control presente en varios equipos 
propuestos por el docente. 

Describe la forma de operación de 
los sistemas de control 
identificados. 

Explica con fundamentos su 
planteamiento. 

Sintetiza evidencias obtenidas para 
producir conclusiones y formular 
nuevas preguntas al determinar el 
tipo de sistema de control. 

Identifica el tipo de sistema de 
control presente en varios equipos 
propuestos por el docente. 

Describe la forma de operación de 
los sistemas de control 
identificados. 

Explica con fundamentos su 
planteamiento. 

Omite alguna de las siguientes 
actividades: 

 Identificar el tipo de sistema de 
control presente en varios 
equipos propuestos por el 
docente. 

 Describir la forma de 
operación de los sistemas de 
control identificados. 

 Explicar con fundamentos su 
planteamiento. 

Elaboración de una 
maqueta. 40% 

Representa cada componente 
hardware por un bloque en la 
maqueta y en el interior de éste el 
software residente. 

Une los bloques para representar 
la forma en que interactúan. 

Cultiva relaciones interpersonales 
que contribuyen a su desarrollo 
humano y el de quienes lo rodean 
al realizar la maqueta del sistema 
de control 

Representa cada componente 
hardware por un bloque en la 
maqueta y en el interior de éste el 
software residente. 

Une los bloques para representar 
la forma en que interactúan. 

Omite alguna de las siguientes 
actividades: 

 Representar cada componente 
hardware por un bloque en la 
maqueta y en el interior de 
éste el software residente. 

 Unir los bloques para 
representar la forma en que 
interactúan. 

 100%  
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MATRIZ DE VALORACIÓN O RÚBRICA 

Siglema:  ISCC Nombre del 
módulo: 

Instalación de sistemas de control por 
computadora. 

Nombre del 
alumno:   

Docente evaluador:  Grupo:  Fecha:  

Resultado de 
aprendizaje: 

1.4 Maneja los componentes de un sistema de 
control por computadora.

Actividad de 
evaluación:  

1.4.1 Presentación de un caso real de un sistema de 
control por computadora. 

 

INDICADORES % C  R  I  T  E  R  I  O  S 
Excelente Suficiente Insuficiente 

Identificación de la 
configuración hardware. 30% 

Identifica los bloques en un sistema 
de control. 

Verifica las generalidades 
operativas, el puerto RS 232, el 
sistema de control formado por 
microprocesador, circuitos 
integrados de control, fuente de 
alimentación y relevadores. 

Identifica las funciones de control 
que realizan los componentes de 
hardware que conforman el 
sistema de control. 

Enfrenta las dificultades que se le 
presentan al identificar la 
configuración del hardware del 
sistema de control, tomando en 
cuenta sus valores, fortalezas y 
debilidades al respecto. 

Identifica los bloques en un 
sistema de control. 

Verifica las generalidades 
operativas, el puerto RS 232, el 
sistema de control formado por 
microprocesador, circuitos 
integrados de control, fuente de 
alimentación y relevadores. 

Identifica las funciones de control 
que realizan los componentes de 
hardware que conforman el 
sistema de control. 

Omite alguna de las siguientes 
actividades: 

 Identificar los bloques en un 
sistema de control. 

 Verificar las generalidades 
operativas, el puerto RS 232, 
el sistema de control formado 
por microprocesador, circuitos 
integrados de control, fuente 
de alimentación y relevadores. 

 Identificar las funciones de 
control que realizan los 
componentes de hardware que 
conforman el sistema de 
control. 

Identificación de la 
configuración software. 30% Identifica los programas de control 

que residen en cada componente, 
Identifica los programas de control 
que residen en cada componente, 

Omite alguna de las siguientes 
actividades: 



  

 
 ISCC-O2 75/81 

 

Guía Pedagógica y de Evaluación del Módulo: 
Instalación de sistemas de control por computadora

INDICADORES % C  R  I  T  E  R  I  O  S 
Excelente Suficiente Insuficiente 

como son el firmware y el software 
de la computadora, describiendo 
las funciones de control que 
realizan. 

Toma una fotografía al circuito de 
control terminado. 

Enfrenta las dificultades que se le 
presentan al identificar la 
configuración del software del 
sistema de control y aprovecha los 
errores para mejorar su trabajo. 

como son el firmware y el software 
de la computadora. 

Describe las funciones de control 
que realizan. 

Toma una fotografía al circuito de 
control terminado. 

 Identificar los programas de 
control que residen en cada 
componente, como son el 
firmware y el software de la 
computadora. 

 Describir las funciones de 
control que realizan. 

 Tomar una fotografía al 
circuito de control terminado. 

Presentación de los 
resultados. 40% 

Reporta el desarrollo y los 
resultados obtenidos. 

Incluye la estructura hardware y 
software con todos los 
componentes, sus funciones de 
control, el tipo de control que 
realiza el sistema. 

Incluye gráficas que apoyen la 
descripción de la práctica y sus 
resultados. 

Aplica distintas estrategias 
comunicativas al presentar los 
resultados a sus compañeros, 
considerando los objetivos que 
persigue. 

Reporta el desarrollo y los 
resultados obtenidos. 

Incluye la estructura hardware y 
software con todos los 
componentes, sus funciones de 
control, el tipo de control que 
realiza el sistema. 

Incluye gráficas que apoyen la 
descripción de la práctica y sus 
resultados. 

Omite alguna de las siguientes 
actividades: 

 Reportar el desarrollo y los 
resultados obtenidos. 

 Incluir la estructura hardware y 
software con todos los 
componentes, sus funciones 
de control, el tipo de control 
que realiza el sistema. 

 Incluir gráficas que apoyen la 
descripción de la práctica y 
sus resultados. 

 100%  
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MATRIZ DE VALORACIÓN O RÚBRICA 

Siglema:  ISCC Nombre del 
módulo: 

Instalación de sistemas de control por 
computadora. 

Nombre del 
alumno:   

Docente evaluador:  Grupo:  Fecha:  

Resultado de 
aprendizaje: 

2.1 Opera los dispositivos de control del sistema por 
computadora. 

Actividad de 
evaluación:  

2.1.1 Presenta la operación de un simulador y los 
resultados obtenidos. 

 

INDICADORES % C  R  I  T  E  R  I  O  S 
Excelente Suficiente Insuficiente 

Manejo de las funciones 
del sistema de control por 
computadora 

30% 

Manipula las funciones que realiza 
un sistema de control por 
computadora. 

Opera las funciones abrir y cerrar 
un instrumento virtual, la función 
del panel frontal, diagrama de 
bloque y la construcción de un 
instrumento virtual. 

Identifica las actividades que le 
resultan de menor y mayor interés 
y dificultad en el manejo de las 
funciones que realiza un sistema 
de control por computadora; y 
enfrenta de manera positiva los 
retos y obstáculos que se 
presentan en la construcción de un 
instrumento virtual. 

Manipula las funciones que realiza 
un sistema de control por 
computadora. 

Opera las funciones abrir y cerrar 
un instrumento virtual, la función 
del panel frontal, diagrama de 
bloque y la construcción de un 
instrumento virtual. 

Omite alguna de las siguientes 
actividades: 

 Manipular las funciones que 
realiza un sistema de control 
por computadora. 

 Operar  las funciones abrir y 
cerrar un instrumento virtual, la 
función del panel frontal, 
diagrama de bloque y la 
construcción de un instrumento 
virtual 

Operación del Panel 
frontal 30% 

Opera las diferentes funciones y 
aplicaciones del panel frontal. 

Maneja la creación de sub VI en las 

Opera las diferentes funciones y 
aplicaciones del panel frontal. 

Maneja la creación de sub VI en 

Omite alguna de las siguientes 
actividades: 

 Operar las diferentes funciones 
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INDICADORES % C  R  I  T  E  R  I  O  S 
Excelente Suficiente Insuficiente 

funciones de simulación de control, 
asignando las terminales al control 
digital. 

Identifica los sistemas y reglas o 
principios medulares que subyacen 
a la operación del panel frontal y 
sub VI. 

las funciones de simulación de 
control, asignando las terminales al 
control digital. 

y aplicaciones del panel frontal. 

 Manejar la creación de sub VI 
en las funciones de simulación 
de control, asignando las 
terminales al control digital. 

Reporte de operación del 
simulador. 40% 

Describe el proceso de simulación, 
el instrumento utilizado y las 
funciones de abrir y cerrar, panel 
de frontal, instrumento virtual. 

Describe la forma en que realizan 
funciones de control a través del 
computador. 

Elabora y registra conclusiones 
sobre el tema. 

Elige las fuentes de información 
más relevantes en la elaboración 
del reporte de operación del 
simulador y discrimina entre ellas 
de acuerdo a su relevancia y 
confiabilidad. 

Describe el proceso de simulación, 
el instrumento utilizado y las 
funciones de abrir y cerrar, panel 
de frontal, instrumento virtual. 

Describe la forma en que realizan 
funciones de control a través del 
computador. 

Elabora y registra conclusiones 
sobre el tema. 

Omite alguna de las siguientes 
actividades: 

 Describir el proceso de 
simulación, el instrumento 
utilizado y las funciones de 
abrir y cerrar, panel de frontal, 
instrumento virtual. 

 Describir la forma en que 
realizan funciones de control a 
través del computador. 

 Elaborar y registrar 
conclusiones sobre el tema. 

 100%  
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MATRIZ DE VALORACIÓN O RÚBRICA 

Siglema:  ISCC Nombre del 
módulo: 

Instalación de sistemas de control por 
computadora. 

Nombre del 
alumno:   

Docente evaluador:  Grupo:  Fecha:  

Resultado de 
aprendizaje: 

2.2 Opera los componentes de interfase de la 
computadora con las facilidades de los sistemas de 
control por computadora. 

Actividad de 
evaluación:  2.2.1 Identifica las funciones de LabView. 

 

INDICADORES % C  R  I  T  E  R  I  O  S 
Excelente Suficiente Insuficiente 

Construcción y ejecución 
de un instrumento virtual. 30% 

Realiza la construcción de un 
instrumento virtual a través de 
plantillas en LabView, a partir de la 
herramienta Window Show. 

Incorpora controles y relaciona,  
objetos modificando así el 
instrumento virtual, adecuándolo a 
los requerimientos. 

Ejecuta el instrumento virtual,  
identifica interfaces y las asocia 
con el entorno de un sistema de 
control por computadora. 

Sigue las instrucciones y el 
procedimiento de construcción y 
ejecución de un instrumento virtual 
en LabView. 

Realiza la construcción de un 
instrumento virtual a través de 
plantillas en LabView, a partir de la 
herramienta Window Show. 

Incorpora controles y relaciona,  
objetos modificando así el 
instrumento virtual, adecuándolo a 
los requerimientos. 

Ejecuta el instrumento virtual,  
identifica interfaces y las asocia 
con el entorno de un sistema de 
control por computadora. 

Omite alguna de las siguientes 
actividades: 

 Realizar la construcción de un 
instrumento virtual a través de 
plantillas en LabView, a partir 
de la herramienta Window 
Show. 

 Incorporar controles y 
relacionar  objetos 
modificando así el instrumento 
virtual. 

 Ejecutar el instrumento virtual,  
identificar interfaces y las 
asociarlas con el entorno de un 
sistema de control por 
computadora. 

Adquisición de datos y 
comunicación con 

40% 
Verifica que esté instalada la 
función tradicional para adquisición 
de datos en LabView y aplicarla 

Verifica que esté instalada la 
función tradicional para 
adquisición de datos en LabView y 

Omite alguna de las siguientes 
actividades: 
 Verificar que esté instalada la 
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INDICADORES % C  R  I  T  E  R  I  O  S 
Excelente Suficiente Insuficiente 

instrumentos virtuales.  con datos analógicos.  

Utiliza software de comunicación 
para realizar el control de un 
instrumento. 

Se comunica en una segunda 
lengua al realizar la adquisición de 
datos y la comunicación con 
instrumentos virtuales en la 
simulación de un sistema de 
control. 

aplicarla con datos analógicos.  

Utiliza software de comunicación 
para realizar el control de un 
instrumento. 

función tradicional para 
adquisición de datos en 
LabView y aplicarla con datos 
analógicos.  

 Utilizar software de 
comunicación para realizar el 
control de un instrumento. 

Operación del simulador 
LabView. 30% 

Describe la estructura de operación 
de LabView, sus funciones, 
facilidades y beneficios. 

Desarrolla un diagrama a bloques 
en donde representa la forma en 
que se realizan las funciones de 
control en el simulador LabView y 
sus resultados. 

Opera el simulador LabView, 
identificando sus alcances y 
limitaciones. 

Asume una actitud constructiva, 
congruente con los conocimientos 
y habilidades adquiridos en el 
manejo de las funciones de 
LabView. 

Describe la estructura de operación 
de LabView, sus funciones, 
facilidades y beneficios. 

Desarrolla un diagrama a bloques 
en donde representa la forma en 
que se realizan las funciones de 
control en el simulador LabView y 
sus resultados. 

Opera el simulador LabView, 
identificando sus alcances y 
limitaciones. 

Omite alguna de las siguientes 
actividades: 

 Describir la estructura de 
operación de LabView, sus 
funciones, facilidades y 
beneficios. 

 Desarrollar un diagrama a 
bloques en donde representa 
la forma en que se realizan las 
funciones de control en el 
simulador LabView y sus 
resultados. 

 Operar el simulador LabView, 
identificando sus alcances y 
limitaciones. 

 100%  
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MATRIZ DE VALORACIÓN O RÚBRICA 

Siglema:  ISCC Nombre del 
módulo: 

Instalación de sistemas de control por 
computadora. 

Nombre del 
alumno:   

Docente evaluador:  Grupo:  Fecha:  

Resultado de 
aprendizaje: 

2.2 Instalar los diferentes componentes físicos y 
lógicos de un sistema de control por 
computadora, respetando las recomendaciones 
de diseño técnico de los fabricantes y 
especialistas. 

Actividad de 
evaluación:  2.3.1 Instala LabView y lo opera. 

 

INDICADORES % C  R  I  T  E  R  I  O  S 
Excelente Suficiente Insuficiente 

Instalación de LabView. 45% 

Interpreta el manual del proveedor 
verificando que se realizan todos 
los pasos de instalación de 
LavView.  

Concluye con el proceso de 
instalación de una manera exitosa 
y deja las licencias en la misma 
carpeta donde se encuentra los 
archivos de instalación. 

Utiliza las tecnologías de la 
información y comunicación para 
procesar e interpretar información 
durante la instalación de LabView. 

Interpreta el manual del proveedor 
verificando que se realizan todos 
los pasos de instalación de 
LavView.  

Concluye con el proceso de 
instalación de una manera exitosa 
y deja las licencias en la misma 
carpeta donde se encuentra los 
archivos de instalación. 

Omite alguna de las siguientes 
actividades: 

 Interpretar el manual del 
proveedor verificando que se 
realizan todos los pasos de 
instalación de LavView.  

 Concluir con el proceso de 
instalación de una manera 
exitosa y dejar las licencias 
en la misma carpeta donde 
se encuentra los archivos de 
instalación. 

Manejo de funciones del 
simulador LabView  45% 

Identifica las funciones de 
simulación de LabView. 

Verifica la utilidad de las funciones. 

Realiza la demostración de 

Identifica las funciones de 
simulación de LabView. 

Verifica la utilidad de las funciones. 

Realiza la demostración de 

Omite alguna de las siguientes 
actividades: 

 Identificar las funciones de 
simulación de LabView. 
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INDICADORES % C  R  I  T  E  R  I  O  S 
Excelente Suficiente Insuficiente 

funciones y operación de LabView. 

Ordena información de acuerdo a 
categorías, jerarquías y relaciones 
al elaborar el reporte y la 
presentación de las funciones de 
LabView. 

funciones y operación de LabView.  Verificar la utilidad de las 
funciones. 

 Realizar la demostración de 
funciones y operación de 
LabView. 

Coevaluación 
Competencias genéricas: 
Aprende de forma 
autónoma 
7. Aprende por iniciativa e 

interés propio a lo largo de 
la vida. 10% 

 

 

 

 

Realiza sus actividades evitando 
acciones que lo pongan en riesgo 
a él o a sus compañeros de equipo 
y de grupo. 

Articula saberes de diversos 
campos y establece relaciones 
entre ellos y su vida cotidiana. 

Aplica sus conocimientos en la 
solución de problemas de su vida 
personal y laboral. 

 

 

 

 

Realiza sus actividades evitando 
acciones que lo pongan en riesgo 
a él o a sus compañeros de equipo 
y de grupo. 

Articula saberes de diversos 
campos y establece relaciones 
entre ellos y su vida cotidiana. 

 

 

 

Omite alguna de las siguientes 
actividades: 

 Realizar sus actividades 
evitando acciones que lo 
pongan en riesgo a él o a sus 
compañeros de equipo y de 
grupo. 

 Articular saberes de diversos 
campos y establece 
relaciones entre ellos y su 
vida cotidiana. 

 

 100%  

 


